Disclaimer

Thunderhead Engineering makes no warranty, expressed or implied, to users of Pathfinder, and accepts no responsibility for its use. Users of Pathfinder assume sole responsibility under Federal law for determining the appropriateness of its use in any particular application; for any conclusions drawn from the results of its use; and for any actions taken or not taken as a result of analyses performed using these tools.

Users are warned that Pathfinder is intended for use only by those competent in the field of egress modeling. Pathfinder is intended only to supplement the informed judgment of the qualified user. The software package is a computer model that may or may not have predictive capability when applied to a specific set of factual circumstances. Lack of accurate predictions by the model could lead to erroneous conclusions. All results should be evaluated by an informed user.
Acknowledgements

This work was originally made possible by a Small Business Innovative Research (SBIR) grant by the United States National Science Foundation.

We would like to thank Rolf Jensen and Associates for their assistance with testing and other suggestions that helped guide the development of the simulator.

We would also like to thank the beta testers whose feedback helped us improve the software and incorporate more useful features.
Note on use of “THEY” as singular pronoun

In this document we use “THEY” as a singular pronoun. As stated in the Random House Dictionary of 1987:

Long before the use of generic HE was condemned as sexist, the pronouns, THEY, and THEM were used in educated speech and in all but the most formal writing to refer to indefinite pronouns and to singular nouns of general personal reference probably because such nouns are often not felt to be exclusively singular. Such use is not a recent development, nor is it a mark of ignorance.

See also the online Oxford dictionary at: http://oxforddictionaries.com/words/he-or-she-versus-they.
Table of Contents

1. Introduction .................................................................................................................. 1
   Graphical User Interface ................................................................................................. 1
   Model Representation ...................................................................................................... 3
   Simulation Modes ............................................................................................................ 4
   Limitations and Known Issues ....................................................................................... 4
   Simulator Name .............................................................................................................. 4
   Contact Us .................................................................................................. 4

2. Pathfinder Basics .......................................................................................................... 5
   Navigation View ............................................................................................................. 5
   3D and 2D Views .......................................................................................................... 6
      Navigating the 3D view ................................................................................................. 6
      Navigating the 2D view ................................................................................................. 7
   Resetting the view ......................................................................................................... 7
   Filling the view ............................................................................................................... 7
   Drawing in the 3D and 2D views ..................................................................................... 8
   View Options ................................................................................................................ 8
      Render Options ........................................................................................................... 8
      Occupant Display ....................................................................................................... 9
      Coloring Rooms ........................................................................................................ 9
      Room Opacity ........................................................................................................... 9
   Model Organization with Groups .................................................................................. 9
      Creating sub-groups .................................................................................................... 10
      Changing groups ....................................................................................................... 10

3. Creating Movement Space ............................................................................................ 11
   Floors ............................................................................................................................ 11
      Automatically creating floors ..................................................................................... 11
      Manually creating floors ........................................................................................... 13
      Changing the active floor ............................................................................................ 13
      Showing all floors ...................................................................................................... 14
      Editing floors ............................................................................................................ 14
   Rooms .......................................................................................................................... 14
      Adding new rooms ..................................................................................................... 14
      Adding thin walls to rooms ....................................................................................... 16
      Splitting rooms ........................................................................................................ 16
      Separating and merging rooms ................................................................................. 17
   Obstructions/Holes ........................................................................................................ 18
      Arbitrarily-Shaped Obstructions (Desks, Tables, etc.) ................................................. 18
   Walls ............................................................................................................................ 19
   Doors ............................................................................................................................ 20
      Thin Doors ............................................................................................................... 20
      Thick doors ............................................................................................................. 21
   Stairs ............................................................................................................................. 22
      Stairs between edges ................................................................................................. 23
      Stairs extending from one edge ................................................................................ 24
   Ramps ........................................................................................................................... 25
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5. Editing and Copying Objects</td>
<td>49</td>
</tr>
<tr>
<td>Transforming and Copying Objects</td>
<td>49</td>
</tr>
<tr>
<td>Moving</td>
<td>49</td>
</tr>
<tr>
<td>Rotating</td>
<td>50</td>
</tr>
<tr>
<td>Mirroring</td>
<td>52</td>
</tr>
<tr>
<td>Manipulating Objects with Handles</td>
<td>53</td>
</tr>
<tr>
<td>Selecting and deselecting a handle</td>
<td>53</td>
</tr>
<tr>
<td>Editing a handle</td>
<td>54</td>
</tr>
<tr>
<td>Room handles</td>
<td>54</td>
</tr>
<tr>
<td>Thin door handles</td>
<td>54</td>
</tr>
<tr>
<td>Thick door handles</td>
<td>55</td>
</tr>
<tr>
<td>Stair and Ramp handles</td>
<td>55</td>
</tr>
<tr>
<td>Occupant handles</td>
<td>55</td>
</tr>
<tr>
<td>Waypoint handles</td>
<td>56</td>
</tr>
<tr>
<td>6. Model Analysis</td>
<td>57</td>
</tr>
<tr>
<td>Measuring Distances</td>
<td>57</td>
</tr>
<tr>
<td>Exiting</td>
<td>30</td>
</tr>
<tr>
<td>Importing Files</td>
<td>31</td>
</tr>
<tr>
<td>Importing images</td>
<td>31</td>
</tr>
<tr>
<td>Importing CAD files</td>
<td>32</td>
</tr>
<tr>
<td>Importing PyroSim and FDS files</td>
<td>34</td>
</tr>
<tr>
<td>Working with Imported Data</td>
<td>34</td>
</tr>
<tr>
<td>Working with Images</td>
<td>34</td>
</tr>
<tr>
<td>Working with 3D CAD, PyroSim, and FDS files</td>
<td>34</td>
</tr>
<tr>
<td>Working with 2D DXFs</td>
<td>35</td>
</tr>
<tr>
<td>Filling in missing pieces</td>
<td>37</td>
</tr>
<tr>
<td>4. Creating Occupants</td>
<td>38</td>
</tr>
<tr>
<td>Profiles</td>
<td>38</td>
</tr>
<tr>
<td>Seeds</td>
<td>40</td>
</tr>
<tr>
<td>Customizing Occupants</td>
<td>41</td>
</tr>
<tr>
<td>Behaviors</td>
<td>41</td>
</tr>
<tr>
<td>Creating a new Behavior</td>
<td>41</td>
</tr>
<tr>
<td>Adding actions</td>
<td>42</td>
</tr>
<tr>
<td>Goto Waypoint action</td>
<td>43</td>
</tr>
<tr>
<td>Goto Rooms action</td>
<td>44</td>
</tr>
<tr>
<td>Goto Elevators action</td>
<td>44</td>
</tr>
<tr>
<td>Wait action</td>
<td>45</td>
</tr>
<tr>
<td>Adding Occupants</td>
<td>45</td>
</tr>
<tr>
<td>Individual placement</td>
<td>45</td>
</tr>
<tr>
<td>Group Placement</td>
<td>46</td>
</tr>
<tr>
<td>Placement in rooms</td>
<td>47</td>
</tr>
<tr>
<td>Redistributing Profiles and Behaviors</td>
<td>47</td>
</tr>
<tr>
<td>Elevators</td>
<td>25</td>
</tr>
<tr>
<td>Creating Elevators</td>
<td>26</td>
</tr>
<tr>
<td>Elevator Representation</td>
<td>28</td>
</tr>
<tr>
<td>Editing Elevators</td>
<td>28</td>
</tr>
<tr>
<td>Nominal Load</td>
<td>30</td>
</tr>
<tr>
<td>Connecting/Disconnecting Floors</td>
<td>30</td>
</tr>
</tbody>
</table>
Figures
Figure 1: An example of the graphical user interface ................................................................. 1
Figure 2: An example of the 3D Results .................................................................................... 2
Figure 3: An example time history graph .................................................................................. 3
Figure 4: 3D and 2D views ........................................................................................................ 6
Figure 5: Render options ............................................................................................................ 8
Figure 6: Predefined groups ...................................................................................................... 10
Figure 7: Floor Creation panel ................................................................................................. 12
Figure 8: Auto floor creation and sorting .................................................................................. 12
Figure 9: Adding a new floor .................................................................................................... 13
Figure 10: Floor property panel ............................................................................................... 14
Figure 11: Drawing a room with the polygon tool .................................................................... 15
Figure 12: Drawing a room with the rectangle tool ................................................................. 15
Figure 13: Adding a thin wall to a room ..................................................................................... 16
Figure 14: Dividing a room ....................................................................................................... 16
Figure 15: Special case for drawing a thin wall ........................................................................ 17
Figure 16: Merging rooms ........................................................................................................ 17
Figure 17: Separating a room ................................................................................................... 18
Figure 18: Creating an obstruction ........................................................................................... 19
Figure 19: Subtracting walls ..................................................................................................... 19
Figure 20: Door tool property panel ........................................................................................ 20
Figure 21: Adding a thin door to connect two touching rooms ................................................ 21
Figure 22: Adding a thick door in the empty space between two rooms ................................... 22
Figure 23: Stair geometry requirements .................................................................................. 23
Figure 24: Property panel for the two-point stair tool .............................................................. 23
Figure 25: Drawing stairs with the two-point stair tool .......................................................... 24
Figure 26: Property panel for the one-point stair tool ............................................................. 24
Figure 27: Drawing stairs using the one-point stair tool ........................................................ 25
Figure 28: Creating an Elevator ............................................................................................... 27
Figure 29: New Elevator dialog ............................................................................................... 27
Figure 30: Elevator representation .......................................................................................... 28
Figure 31: Elevator property panel ......................................................................................... 28
Figure 32: Elevator Priority dialog ........................................................................................ 29
Figure 33: Elevator Levels dialog ........................................................................................... 30
Figure 34: An exit door ............................................................................................................. 31
Figure 35: Importing a background image ............................................................................... 32
Figure 36: Dxf unit dialog box .................................................................................................. 33
Figure 37: Drawing rooms over a background image .............................................................. 34
Figure 38: Property panel for the floor extraction tool ............................................................ 35
Figure 39: A room extracted from a PyroSim file .................................................................... 35
Figure 40: Room extraction results from an imported 2D Floorplan .......................................................... 36
Figure 41: Using the door tool to fill a doorway ......................................................................................... 37
Figure 42: The Edit Profiles dialog ............................................................................................................. 38
Figure 43: An example of the 3D model dialog ............................................................................................. 39
Figure 44: Using a custom occupant profile ................................................................................................. 41
Figure 45: New Behavior dialog .................................................................................................................. 42
Figure 46: Behavior Property Panel ............................................................................................................. 42
Figure 47: Exit Chooser dialog ..................................................................................................................... 42
Figure 48: Behavior actions list .................................................................................................................... 43
Figure 49: Example of action order for a behavior ....................................................................................... 43
Figure 50: Goto Waypoint creation panel ..................................................................................................... 44
Figure 51: Goto Rooms creation panel ........................................................................................................ 44
Figure 52: Goto Elevators creation panel .................................................................................................... 44
Figure 53: Wait creation panel ...................................................................................................................... 45
Figure 54: Adding occupants individually ................................................................................................... 45
Figure 55: Add Rectangular Group of Occupants Property Panel ................................................................. 46
Figure 56: Editing the distribution of profiles ............................................................................................... 46
Figure 57: Distributing occupants in a rectangular region ............................................................................ 47
Figure 58: Distributing occupants through entire rooms ........................................................................... 47
Figure 59: Edit Group Distributions dialog ................................................................................................. 48
Figure 60: Property panel for the translate tool ........................................................................................... 49
Figure 61: Graphically moving an object ...................................................................................................... 50
Figure 62: Creating an array of objects by using the translate tool ............................................................... 50
Figure 63: Property panel for the rotate tool ............................................................................................... 51
Figure 64: Rotating an object ....................................................................................................................... 51
Figure 65: Creating an array of objects using the rotate tool ....................................................................... 52
Figure 66: Property panel for the mirror tool .............................................................................................. 52
Figure 67: Mirroring an object ..................................................................................................................... 53
Figure 68: Manipulator handles .................................................................................................................. 53
Figure 69: Handle property panel ................................................................................................................. 54
Figure 70: Door handles ............................................................................................................................... 54
Figure 71: Stair/ramp handles ...................................................................................................................... 55
Figure 72: Agent handles ............................................................................................................................. 55
Figure 73: Waypoint handles ....................................................................................................................... 56
Figure 74: Connectivity example ................................................................................................................ 57
Figure 75: Select Connected Components dialog ........................................................................................ 58
Figure 76: Selecting an entire graph of connected components .................................................................... 59
Figure 77: The Behavior tab of the Simulation Parameters Dialog .............................................................. 61
Figure 78: The Run Simulation dialog showing a partially complete simulation ........................................ 64
Figure 79: Listing for an example summary report file ................................................................................. 66
Figure 80: A time history plot for door flow rates ....................................................................................... 67
Figure 81: 3D Results for the multi-floor-stairwell example problem .......................................................... 68
Figure 82: Floor location dialog for 3D results .......................................................................................... 70
Figure 83: Multi-floor layout options in 3D results (FDS model courtesy of Andreas Niggemeyer) ........ 71
Figure 84: Movie option dialogs ........................................................................................................... 74
1. Introduction

1. Pathfinder is an agent based egress and human movement simulator. It provides a graphical user interface for simulation design and execution as well as 2D and 3D visualization tools for results analysis.

Graphical User Interface

Pathfinder includes a graphical user interface that is used primarily to create and run simulation models. A screenshot of this user interface is shown in Figure 1. This screenshot displays a model that is being created from an imported floor plan image.

![Figure 1: An example of the graphical user interface](image)

Pathfinder also includes a second program designed specifically for high-performance visualization of 3D time history. The 3D Results program is shown in Figure 2. In this image, occupants are moving on a model that used an imported floor plan image.
In addition to 3D visualization, Pathfinder also provides output in the form of 2D time history plots of CSV (comma separated values) out files and a text summary of room clearing times and doorway flow rates. An example time history plot can be seen in Figure 3. This plot shows the number of occupants in various rooms.
Figure 3: An example time history graph

Model Representation

The movement environment is a 3D triangulated mesh designed to match the real dimensions of a building model. This movement mesh can be entered manually or automatically based on imported data (e.g. FDS geometry).

Walls and other impassable areas are represented as gaps in the navigation mesh. These objects are not actually passed along to the simulator, but are represented implicitly because occupants cannot move in places where no navigation mesh has been created.

Doors are represented as special navigation mesh edges. In all simulations, doors provide a mechanism for joining rooms and tracking occupant flow. Depending on the specific selection of simulation options, doors may also be used to explicitly control occupant flow.

Stairways are also represented as special navigation mesh edges and triangles. Occupant movement speed is reduced to a factor of their level travel speed based on the incline of the stairway. Each stairway implicitly defines two doors. These doors function just like any other door in the simulator but are controlled via the stairway editor in the user interface to ensure that no geometric errors result from a mismatch between stairways and the connecting doors.

Occupants are modeled as upright cylinders on the movement mesh and travel using an agent-based technique called inverse steering. Each occupant calculates movements independently and can be given a unique set of parameters (maximum speed, exit choice, 3D model, etc).
**Simulation Modes**
Pathfinder supports two movement simulation modes. In "Steering" mode, doors do not act to limit the flow of occupants; instead, occupants use the steering system to maintain a reasonable separation distance. In SFPE mode, occupants make no attempt to avoid one another and are allowed to interpenetrate, but doors impose a flow limit and velocity is controlled by density.

You can freely switch between the two modes within the Pathfinder user interface and compare answers. More information about both modes is provided in the Technical Reference manual.

**Limitations and Known Issues**
Pathfinder 2011 does not integrate results from a fire model or provide support for complex behaviors (e.g. family grouping).

Dynamic geometry is only partially supported (e.g. elevators are supported, but opening/closing doors, escalators, trains, etc. are not).

Elevators are supported in evacuation-only circumstances. They do not model a general-purpose elevator system.

**Simulator Name**
The name Pathfinder has been used previously to describe an egress simulator. The original Pathfinder is a 2D egress simulator created and used internally by Rolf Jensen and Associates. While the original Pathfinder inspired some of the features of the new simulator, the simulator described in this manual does not use any of the code from the original Pathfinder software.

**Contact Us**
Thunderhead Engineering
403 Poyntz Avenue, Suite B
Manhattan, KS 66502-6081
USA

Sales Information: sales@thunderheadeng.com
Product Support: support@thunderheadeng.com
Phone and Fax: +1.785.770.8511
2. Pathfinder Basics
Pathfinder provides three main views for working on evacuation models: the 2D View, 3D view, and Navigation View. These views represent your current model. If an object is added, removed, or selected in one view, the other views will simultaneously reflect the change. Each view is briefly described below.

- **Navigation View**: This view lists all objects in the model in a hierarchical format. It can be used to quickly locate and modify objects by name.
- **3D View**: This view shows a 3D representation of the current model. The model can be explored and modified using various tools.
- **2D View**: This view is very similar to the 3D View, but it provides an additional snapping grid and an orthographic view of the model.

### Navigation View
The Navigation View helps you quickly find objects and data that are not always easily accessible from the 3D and 2D views.

The Navigation View is arranged in four groups:

1. The *Imported geometry* group stores items that were imported from an image or an FDS, PyroSim, or DXF model. These objects do not affect the simulation but are carried through to help with results analysis. They can also be used to automatically extract rooms.
2. The *Profiles* group contains the occupant profiles that have been created using the Edit Profiles dialog.
3. The *Behaviors* group contains user-defined scripts that tell occupants how to behave.
4. The *Occupants* group contains every occupant in the model. If occupants are added to the model using a tool that adds more than one occupant at a time, they will be collected in a sub-group.
5. The *Elevators* group contains evacuation elevators in the model.
6. The *Floors* group defines the floors in the model, and each floor contains all geometry necessary to create a movement mesh, including room, stairway, ramp, door, and exit definitions.

The buttons directly above the Navigation View perform the following actions:

- **Auto Expand Selection** when an object (or occupant) in the 3D or 2D view is selected, this action will expand the groups of the Navigation View as needed to show the selected object.
- **Collapse All** collapses all expanded groups in the Navigation View.
- **Expand All** expands all groups in the Navigation View (including sub-groups).
The **Floor** box above the view can be used to manage floors. Any time a room, stair, ramp, or door is created it is added to a floor group matching the current selection in the **Floor** box. Changing the selection in the **Floor** box will cause the newly selected floor to be shown and all other floors to be hidden. Also, the Z property for all drawing tools will automatically default to the height of the floor currently selected in the **Floor** box. The visibility of any object or group of objects can always be manually set using the right-click context menu. This technique is useful if you want to show two floors at the same time (e.g. when creating a stairway).

### 3D and 2D Views

The 3D and 2D views as shown in Figure 4 are the main views in which drawing is performed in Pathfinder. Both views contain tools to draw egress geometry and navigate in a model. The main difference between the two views is that the 3D view allows the model to be viewed from any direction, whereas the 2D view only allows viewing from one, orthographic direction. In addition, the 3D view contains no snap grid, whereas the 2D view does. The 3D view is entered by selecting the perspective camera, 🏛️, and the 2D view is entered by selecting one of the orthographic cameras, 🏛️, 🏛️, or 🏛️.

At the top of the view is several buttons that show different camera modes, display options, and navigation modes. The panel under this is known as the **property panel** and is a selection context-sensitive panel. If a drawing tool is selected, it will show properties that can used to help draw. If no drawing tool is selected, and an object or several objects are selected, this panel will show the properties relevant to the selection. The panel of buttons on the left shows the drawing tools. The small panel at the bottom displays messages relevant to the current tool.

![Figure 4: 3D and 2D views](image)

**Navigating the 3D view**

Several tools are provided for navigating through the model in the 3D view, including orbit, roam, pan, and zoom tools.
The main navigation tool for the 3D view is the Orbit tool, 🌎. By left-clicking and dragging, the model is rotated about its center point. The scroll-wheel can be used to zoom in and out on a specific point. Holding SHIFT on the keyboard and then clicking and dragging will pan the camera, and holding ALT while dragging will zoom in and out.

Another navigation tool in the 3D view is the Roam tool, 🧵. This tool allows the camera to move in and out of the model at will. Without holding any keyboard keys, dragging the mouse will cause the camera to rotate about the camera’s location. So dragging the mouse up will make the camera look up, and dragging it left and right makes it look left and right. Holding CTRL while dragging will make the camera move forward and backward in the XY plane, and holding ALT while dragging will make the camera move up and down along the Z axis. This tool has a higher learning curve but is the most flexible viewing tool because it allows the camera to be placed anywhere in the model.

The other navigation tools include a pan/drag tool, which moves the camera left and right and up and down, a zoom tool, which zooms in and out of the model while click-dragging, and a zoom box tool, which allows a box to be drawn that specifies the zoom extents.

Pathfinder can also be navigated while using the Selection/manipulation tool, 🠞. To Orbit the camera while in perspective view, use a right-click and drag combination. Similarly, use a middle-click and drag to Pan in perspective view.

Navigating the 2D view
Navigation in the 2D view is simpler than in the 3D view. The selection tool not only allows objects to be selected if single-clicked, but it allows the view to be panned by middle or right-clicking and dragging, and the view to be zoomed by using the scroll wheel. The drag and zoom tools are also separated into separate tools for convenience.

Resetting the view
At any time, the camera can be reset by pressing CTRL+R on the keyboard, or selecting Reset All tool, ᵉ. This will cause the entire model to be visible in the current view. For all navigation tools but the Roam tool, reset will make the camera look down the negative Z axis at the model. For the roam tool, however, reset will make the camera look down the negative Y axis at the model.

The camera can also be reset to the current selection at any time by pressing CTRL+E. This will cause the camera to zoom in on the selected objects and the orbit tool to rotate about the center of their bounding sphere.

Filling the view
Very similar to resetting the camera, the view can be fit by pressing F on the keyboard or selecting the Fit View tool, 🌾. The difference between the Fill View and Reset All tools is that filling the screen does not change the view angle of the camera. Instead the camera will recenter/rezoom to fit the screen.
Drawing in the 3D and 2D views

Drawing can be performed in both the 3D view and the top 2D view. The 3D view allows the user to see the model from any angle, but most tools restrict drawing in the XY plane. The top view completely restricts drawing to the XY plane, but it also displays an optional snap grid. The snap grid size can be set under **Edit snap grid spacing** in the **View** menu, and it can be turned off by deselecting **Show Snap Grid** in the **View** menu.

Drawing is performed in one of the two following modes:

- **Normal Mode:** Single-click a drawing tool button on the left side of the view. Draw the object using the instructions in the appropriate section of the manual. When the object has been completed, the drawn object(s) will be selected and the view will revert to the previous navigation tool.

- **Sticky Mode:** Double-click a drawing tool’s button on the left panel before beginning to draw. When the object is completed, the same drawing tool will remain selected and more objects can be drawn with the tool. To escape this mode, press ESC on the keyboard, and the previous navigation tool will be selected. A green dot on the tool’s icon indicates that the tool is currently in sticky mode. Single-clicking the tool’s icon again will turn off sticky mode but keep the tool selected.

At any time while drawing, the user can press escape, which causes the current object to be cancelled and the previous navigation tool to be selected.

For each tool there are often two ways to create its object. One way is to draw the object graphically using the mouse and keyboard. The other is to interactively create the object by typing information such as coordinates, widths, etc. in the tool’s property panel. The property panel will update the graphical preview immediately to reflect changes in the input. This allows fine-grained control in creating the object. The individual drawing tools are discussed in Creating Movement Space.

**View Options**

Pathfinder provides a variety of view options for displaying both navigation geometry and imported geometry that can also aid with drawing. This includes options for rendering geometry, displaying agents, coloring rooms, and setting the transparency of rooms.

**Render Options**

In the toolbar above the properties window in the 2D and 3D views, there are a number of buttons as shown in Figure 5 that control how geometry is rendered.

![Render Options](image)

**Figure 5: Render options**

From left to right, the buttons are **Wireframe Rendering**, **Solid Rendering**, **Show Textures**, **Show Object Outlines**, **Smooth Lighting**, **Display Navigation Geometry**, and **Display Imported Geometry**.
• **Wireframe Rendering**: displays imported 3D geometry as wireframe only. This option is mutually exclusive with the solid rendering option. It is useful for drawing doors in the 2D view when 3D geometry has been imported.

• **Solid Rendering**: displays imported 3D geometry filled in. This is selected by default.

• **Show Object Outlines**: shows the outlines of 3D imported geometry. This is similar to showing the wireframe and solid versions at the same time.

• **Smooth Lighting**: uses a more realistic shading model to show all geometry. This may be a little slower to render on older graphics cards.

• **Display Navigation Geometry**: This toggles the visibility of all the navigation geometry. It does not affect anything else (including imported geometry and occupants).

• **Display Imported Geometry**: This toggles the visibility of all imported 3D geometry.

**Occupant Display**

Occupants can be displayed using a number of options. They can be viewed as simple shapes, including disks and cylinders. They can also be displayed as the artist’s mannequin or as their respective human avatars specified in their profiles. These options are available under **View menu and Agents submenu**.

**Coloring Rooms**

Rooms can be colored in a variety of ways. All coloring options are available under the **View menu and Color Rooms submenu**. The default option is to display each room with a unique color. They can also be colored by occupant density, which means that rooms with a greater concentration of agents will be colored redder, and rooms with a lesser concentration will be colored bluer. The last option is to use a mixed mode. In this mode, the rooms are only colored by concentration if they contain agents; otherwise, they are colored with their unique colors.

**Room Opacity**

Sometimes it is useful to be able to see through rooms and stairways, such as when drawing on top of an imported background image. To change the opacity of a set of components, select them and in the property panel, change the opacity. Opacity settings will carry through to 3D results visualization.

**Model Organization with Groups**

The main method of organization in Pathfinder is to use groups. In every model there are already some implicit groups that cannot be modified, including **Imported Geometry, Profiles, Behaviors, Occupants, Elevators, and Floors** as shown in Figure 6. Sub-groups can be created to further organize the model as discussed in the following sections.
Creating sub-groups
Sub-groups can be created under Imported Geometry, Occupants, Elevators, and Floors (floors are discussed in the section, Floors). Groups can also be created in other sub-groups. To create a new group, right click the desired parent group in the navigation view and select New Group… or select New Group… from the Model menu. A dialog will display allowing the user to select the parent group (which will automatically be selected if performed from the right-click menu) and a name for the new group. Click “OK” to create the new group.

Changing groups
An object can be moved from one group to another at any time. To change an object’s group, drag the object to the desired group in the Navigation View or right click the object and select Change Group…. This will show a dialog that will allow the user to choose the new group. The options shown for the new group will only be valid groups for which the group can be changed. Select “OK” to change the group.
3. Creating Movement Space

Pathfinder is built on the idea of creating floor space on which occupants can walk. Every navigation component drawn in Pathfinder is some piece of flooring that can be travelled on, which can range from floors, to doorways, to stairs. Obstructions exist as holes in the floor.

The main egress components include rooms, which are empty floor spaces bounded by walls, doors, which connect rooms on the same level, stairs/ramps, which connect rooms on different levels, and elevators, which connect multiple levels. Rooms can have any polygonal shape, and can never overlap on the same level. Doors can be either thick if they are occupying a doorway (the area between two rooms) or thin if they are simply connecting two touching rooms. Stairs/ramps are always rectangular and implicitly contain a thin door on each end to connect the adjacent rooms. Elevators can be any shape and can travel in any direction.

To organize egress components, Pathfinder provides the concept of floors, which group together components at different Z locations.

Floors

Floors are the primary method of organization in Pathfinder. At their most basic level, they are simply groups in which rooms, doors, stairs, ramps, and exits can be placed, but they also control the drawing plane for most tools and filtering of imported geometry.

In every Pathfinder model, at least one floor must exist, and at any given time, there is one active floor. Whenever any navigation object is drawn, it will either be placed in the active floor or a subgroup of the active floor.

By default when a new model is started, there is one floor at Z=0, and additional floors are either created automatically depending on where the geometry is drawn or manually created. In addition, new navigation components are automatically sorted into the appropriate floor when drawn.

Automatically creating floors

When nothing is selected in the model, the Floor Creation panel is shown, as in Figure 7. This panel controls the automatic creation of floors and automatic sorting of new objects into floors.

- **Auto sort egress components** – If this is checked, navigation components are automatically sorted into the appropriate floor when created or modified; if this is unchecked, new navigation components are placed in the group specified under New Egress Components and remain in this group until manually moved.
- **Automatically create floors** – If this is checked, floors are automatically created as navigation components are created and modified.
- **Floor height** – This specifies the height at which new floors are automatically created. If a navigation component is created or moved to a location that is at least this distance from the previous floor, a new floor will be created at a multiple of this distance from the previous floor.
• **Group** – If **Auto sort egress components** is unchecked, this drop-down specifies the group/floor for new navigation components.

![Floor Creation/Sorting](image)

![New Egress Components](image)

Figure 7: Floor Creation panel

The following scenario demonstrates how objects are organized when auto-sort and auto-floor-creation are enabled (organization of the model is shown in Figure 8):

1) A new model is created. The floor height is left at the default of 3 m.
2) “Room00” is drawn at Z=0 m, and is auto-placed in “Floor 0.0 m.”
3) “Room01” is drawn at Z=1.5 m, and is auto-placed in “Floor 0.0 m.”
4) “Stair01” is drawn connecting “Room00” to “Room01” and is auto-placed in “Floor 0.0 m.”
5) “Room02” is drawn at Z=-1.5 m. A new floor, “Floor -3.0 m” is auto-created, and “Room02” is auto-placed in it.
6) “Stair02” is drawn connecting “Room02” and “Room00” and is auto-placed in “Floor -3.0 m.”
7) “Room03” is drawn at Z=7.5 m. A new floor, “Floor 6.0 m” is auto-created, and “Room03” is auto-placed in it.

![Floor and Group](image)

Figure 8: Auto floor creation and sorting

In this example, only rooms and stairs were created. The floors were automatically created and the rooms and stairs were automatically sorted into the appropriate ones.

*Working with older files*

Auto floor creation and sorting is a new feature in Pathfinder 2011. When an older model is opened, the original floors and organization is maintained. In some cases the older model may not be sufficiently organized into appropriate floors, however, since it used to be done manually. Automatic floors can still be used for existing navigation components by performing the following:

1) Open the desired model.
2) Clear the selection so that the **Floor Creation** panel is visible (Figure 7). Selection can be cleared by clicking in empty space in the 3D, 2D, or Navigation view.

3) Ensure that the desired creation/sorting options are enabled and that the correct floor height for the model is set.

4) Select all the components that should be auto-sorted (if everything should be sorted, select the **Floors** top node).

5) Right-click the selection, and from the right-click menu, select **Sort into Floors**.

6) The appropriate floors will be created and all selected items will be sorted into the appropriate floors.

**NOTE:** This will not delete any existing floors. If there are undesired existing floors, first move the navigation components out of them to another floor that will be kept, delete the undesired floors, and then perform **Sort into Floors**.

**Manually creating floors**

Floors can also be created manually at any time. To do so, click on the floor drop-down box above the Navigation View, and select ***Add New*** as shown in Figure 9. A dialog will open asking for the floor location. Enter the Z plane location or click on a snap point in the 3D or 2D view and click okay. This Z plane will be used to update the drawing tools’ working Z location when this floor is made active. By default, the name of the floor is “Floor x” where x is the working plane of the floor. If **Set as active floor** is selected in the new floor dialog, the floor is set to be the active floor in the model after being created. If **Resort existing egress components into new floor** is selected, then all existing components that belong in the new floor will be moved to it.

![Figure 9: Adding a new floor](image)

**Changing the active floor**

To change the active floor, click the floor drop-down box as shown in Figure 9, and select the desired floor. This will make that floor active and all other floors non-active.

Whenever the active floor is changed, the following additional changes take place in the model:

- The floor, all objects in the floor group, and all occupants on the floor are set visible.
- All other floors, sub-objects of other floors, and occupants on those floors are set hidden.
- The working plane of the room and wall subtraction tools is set to the working plane of the floor.
- A clipping filter is applied to imported geometry so that only geometry within the Z clipping planes of the active floor is visible.

**Showing all floors**
To show all floors click the floor drop-down box as shown in Figure 9, and click **<Show All>**. This will additionally show all occupants on the floors and all sub-objects of the floors groups, and it will set the import filter to the union of all the floors’ filters.

**Editing floors**
To edit a floor, first select the desired floor. The property panel as shown in Figure 10 will appear, showing the floor’s name, its working Z location, and the Z clipping planes for imported 3D geometry. It also shows some statistics of the floor including the total area of the floor (**Area**), number of people on the floor (**Pers**) and density of people.

The **Working Z** property controls the plane on which new rooms and wall obstructions are drawn.

The Z min and max filters control the clipping planes of imported 3D geometry when the floor is visible. Anything below Z min and above Z max is clipped. The **Z Min Filter** property can either be a Z plane location or can have the special value, **CURR_FLOOR**. If it is **CURR_FLOOR**, then the clipping plane is set to the working Z location if there are any floors below this floor or –∞ if there are no floors below. The **Z Max Filter** can be a Z plane location or can have the special value, **NEXT_FLOOR**. If it is **NEXT_FLOOR**, then the Z plane is set to the working Z plane of the next higher floor if one exists, or +∞ if there are no higher floors.

**Figure 10: Floor property panel**

**Rooms**
Rooms are open space on which occupants can freely travel. Each room is bounded on all sides by walls. Rooms can be drawn so that they touch each other, but an occupant can only travel between them if they are connected by a door. Only one room can occupy a given space at any time, so if one room is drawn overlapping another, the overlapping area will be subtracted from the old room and given to the new. Rooms can also be merged into one, separated into constituent parts, and have internal, thin boundaries drawn in them. These features are discussed in the following sections.

**Adding new rooms**
Pathfinder provides two tools for adding new room geometry.
• **Polygonal Room Tool**: The Polygonal Room tool ( ) allows for the creation of complex shapes with any number of vertices. Left-click anywhere in the model to set the first point, and continue left clicking to add more points to the polygon. When at least three points are defined, right-clicking will close the polygon and complete the shape. Alternatively, x-y coordinates can be entered from the keyboard with the **Add Point** and **Close Polygon** buttons from the property panel.

![Figure 11: Drawing a room with the polygon tool](image)

• **Rectangular Room Tool**: The Rectangular Room tool ( ) creates simple rectangular geometry by left-clicking two points in the model. The rectangular area can also be created by entering coordinates for two points in the property panel and clicking the **Create** button.

![Figure 12: Drawing a room with the rectangle tool](image)

In addition to creating new areas, both of these tools can be used on existing geometry to create negative areas. Creating new geometry over existing areas removes any interfering portion from those areas. The newly created geometry can then be deleted, leaving the negative space behind. This is discussed further in the section, Arbitrarily-Shaped Obstructions (Desks, Tables, etc.).
Adding thin walls to rooms
Thin, internal walls or boundaries can be added to rooms with the Thin Wall tool (圉). To use this tool, click two points in a room as shown in Figure 13. The line between these two rooms must lie in one plane of the room.

![Figure 13: Adding a thin wall to a room](image)

Splitting rooms
Rooms can be split into two or more pieces using the Thin Wall tool. To do this, specify the two points such that they are on the outermost boundary of the room to be divided. The original geometry will be divided into two or more new rooms with that line as the boundary between them as shown in Figure 14.

![Figure 14: Dividing a room](image)

Note that drawing a thin wall between two boundaries of the room will not always split the rooms into multiple pieces as shown in Figure 15. In this case, the tool will simply add a thin wall.
Separating and merging rooms

In addition to dividing rooms, Pathfinder has two additional means to aid in creating more complex room geometry.

- **Merge**: The Merge command is used to join two or more rooms that share boundaries into one room. To use it, select the neighboring rooms and select **Merge** from either the **Model** menu or the right-click menu. **NOTE**: Rooms can be merged even if they do not lie in the same plane as long as they share a common edge. They can also be merged with stairs and ramps, but the stairs and ramps will be converted into rooms and will lose their stair/ramp properties.

- **Separate**: The Separate command breaks a room into its constituent parts along any negative space that divides it. To use it, select the room to be separated and select **Separate** from either the **Model** menu or the right-click menu.
Obstructions/Holes

In Pathfinder, obstructions are modeled as holes in the navigation geometry. Holes can be created with an arbitrary polygonal shape or as thick walls.

Arbitrarily-Shaped Obstructions (Desks, Tables, etc.)

To model an obstruction (e.g. an office desk or other standing obstacle) within a room, the subtractive property of rooms is used. This means that the room containing the obstruction must already exist. To create the obstruction, select the **Add a Polygonal Room** tool or the **Add a Rectangular Room** tool and draw the shape and location of the obstructed area. This will subtract the area from the old room and create a new room. Next, delete the new room. A hole is left in the old room in the shape of the obstruction. This process is shown in Figure 18.

Figure 17: Separating a room
Walls

The wall tool (墙) is used to make rectangular obstructions in existing geometry. To use this tool, enter the desired wall width in the property panel and click or click-drag the two points the wall is to pass through. Holding the shift key will switch between alignment left and right of the defining line. This tool is shown in Figure 19.

Figure 19: Subtracting walls
Doors
In Pathfinder, occupants cannot pass between two rooms unless they are joined by a door. Also, the simulator requires that each occupant must have a path to at least one exit door. Doors provide useful flow measurements in simulation results. Also, in the SFPE mode doors act as the primary flow control mechanism. You can add doors using the Add a New Door tool.

When adding doors, different parameters provide hints to Pathfinder for finding a valid door as shown in Figure 20. The Max Width parameter is used as a target width for the door. If the full width isn't available, Pathfinder will display a shorter door as you hover with the mouse. The Max Depth parameter represents the depth of the door cavity and is used to determine how far apart two rooms can be and still be joined by a door. Doors can be added between rooms that are separated by up to this distance.

![Door tool property panel](image)

Figure 20: Door tool property panel

Thin Doors
Thin doors can be used to connect two rooms that touch one another as shown in Figure 21. A door is needed in this example to allow occupants to travel from one room to the other. To create a door in this manner, first select the door tool and then use one of the following three methods:

- **Manual Entry:** Enter the coordinates of the door in the property panel. If the coordinates specify a valid door location, the Create Door button will enable. Click this button, and a door no larger than Max Width will be created. For thin doors, Max Depth will be ignored.
- **Single Click:** Move the cursor over the desired door location in the 3D or 2D view. A preview door will be displayed if the cursor is on a valid edge. The door displayed will lie either to the left or right of the hover point relative to the boundary edge, depending on whether Max Width is positive or negative. Single click to place the door. The previewed door will then be added to the model.
- **Click-drag:** Move the cursor over the location of one end point of the door, and click and drag along the same edge. While dragging, a preview door will be displayed from the first to the second point. When the mouse is released, a door is created along the edge between the two specified points. Creating a door in this manner ignores all the properties in the tool panel.

The created door will appear as a thin, orange line in the 3D and 2D views as shown in Figure 21.
Thick doors
Thick doors are often useful in realistic models, especially when CAD geometry has been imported. In real scenarios, rooms will not touch each other by infinitely thin walls as shown in Figure 22. To create a thick door to connect these rooms, first select the door tool and then use one of the following three methods:

- **Manual Entry:** Make sure Max Depth is greater than or equal to the distance between the edges the door will lie between. Enter a point on one of the edges in the property panel. If the coordinates specify a valid door location, the Create Door button will enable. Click this button, and a door no larger than Max Width will be created.
- **Single Click:** Make sure Max Depth is greater than or equal to the distance between the edges the door will lie between. Then move the cursor over the desired door location in the 3D or 2D view. A preview door will be displayed extending between the rooms if the cursor is on a valid edge. The door displayed will lie either to the left or right of the hover point relative to the boundary edge, depending on whether Max Width is positive or negative. Single click to place the door.
- **Click-drag:** Move the cursor over the edge of one of the rooms, and click drag along the corresponding edge on the second room. While dragging, a preview door will be displayed connecting the two edges. When the mouse is released, a door is created between the edges of the two rooms, where the diagonal of the rectangular door connects the two specified points. Creating a door in this manner ignores all the properties in the tool panel.

The created door will appear as an orange rectangle in the 3D and 2D views as shown in Figure 22.

When simulating, thick doors have a special representation: the area of the door will be partitioned in two, and each half is attached to its touching room. A thin door is placed in the middle of the area to represent the thick door. Note that the extra area attached to each room is neglected when the area of the room is reported in its property panel, but it is included during simulation.
Figure 22: Adding a thick door in the empty space between two rooms

Stairs
Stairs in Pathfinder are represented by one straight-run of steps. The number of steps, tread width, tread height, and width of the stairs are controlled by two stair tools. One tool allows creation of stairs between two semi-parallel boundaries of rooms on different Z planes, and the other allows creation of stairs that extend from one room boundary until a criterion is met, such as number of steps, height of stairs, etc, or until another room is reached.

All stairs implicitly contain two doors, one at each end of the stairs. The width of each door is controlled through the stair’s **Door 1 Width** and **Door 2 Width** properties. Door 1 is the door at the bottom of the steps, and door 2 is at the top. Stairs also contain tread rise and run properties, which control the speed at which occupants can travel on the stairs during simulation. While the one-point stair tool uses the tread rise and run to create the initial shape of the stair, these properties can later be changed without affecting the shape.

One requirement of all stairs for successful simulation is that each end of the stairs must connect to boundary edges of the rooms, meaning that there must be empty space at the top of the stairway and empty space below the bottom. This requirement is shown in Figure 23. The size of the gap must be greater than or equal to the radius of the largest occupant to travel on the stairs.
Stairs between edges

One way to create stairs is to draw them between two pre-existing rooms. Stairs of this type will match the ends of the stairs exactly to the edges that they were drawn between, which means that the tread rise and run may or may not match the actual slope of the stairs. In Pathfinder, the geometric slope of stairs is unimportant in the simulation, but the specified tread rise and run are.

To create stairs between edges, first ensure that both the connecting rooms are visible. If the rooms are on different floors, at least one room will have to be manually set visible, which can be done through the right-click menu in the Navigation View. Next select the two-point stair tool. The property panel will display the stair creation properties as shown in Figure 24. The stairs can now be created in one of the three following ways:

- **Manual Entry:** Set the desired stair width, and for each edge on which the stairs should be created, enter a point. If the points are valid, a preview stair will be shown in the 2D or 3D view and the Create button will enable. Click the Create button to add the stairs.

- **Two-click:** Set the desired stair width. Move the cursor over the first edge, and a preview line similar to a thin door will appear previewing the top or bottom of the stairs. Single-click to set the point. Now move the cursor over the second edge. Now a preview of the stairs will appear connecting the first edge to the second. Single-click on the second edge to create the stairs.

- **Two-click with drag:** Click-drag on the first edge to specify both the starting point and width of the stairs. Release the mouse and then single-click on the second edge to place the stairs.

![Figure 24: Property panel for the two-point stair tool](image)
Figure 25: Drawing stairs with the two-point stair tool

Stairs extending from one edge
Another way to create stairs is to have them extend from an edge and exactly match the specified tread rise and run. They will stop when they meet a specified criterion or reach another room. The property panel for the one-click stair tool, as shown in Figure 26, provides four ways to terminate the stairs:

- **Step count**: The stair will have this many steps.
- **Total rise**: The stair will be this tall in the Z direction.
- **Total run**: The stair will be this length in the XY plane.
- **Total length**: The hypotenuse of the stair will be this length.

To create stairs in this manner, select the one-point stair tool. The property panel will show. If the tread rise is positive, the stairs will extend up from the starting edge, and if it is negative, the stairs will go down. Similarly, if the tread run is positive, the stairs will extend away from the room, and if it is negative, the stairs will extend in toward the room. Another way to change these values is to hold CTRL on the keyboard to make the tread rise negative and hold SHIFT to make the run negative. Now the stairs can be created in one of the three following ways:

- **Manual Entry**: Set the desired stair width, tread rise, tread run, and termination criterion. Specify the starting point on the desired edge. If the location is valid, a preview stair will be shown, and the **Create** button will enable. Click the button to create the stairs.
- **Single-click**: Set the desired stair width, tread rise, tread run, and termination criterion. Move the cursor over the starting point on the room’s boundary. A preview stair will be displayed. Single click to place the stairs.
- **Click-drag:** Set the desired tread rise, tread run, and termination criterion. Now click-drag along the room’s boundary to specify both the location and the width of the stairs. Release the mouse to create the stairs.

![Figure 27: Drawing stairs using the one-point stair tool](image)

After creating stairs in this manner, the Z location of the next floor or room will have to match the top of the stairs exactly for the next room to connect properly to the stairs. This can be done by clicking the top of the stairs in the 3D or 2D view when choosing the Z location for either the floor or next room.

**Ramps**

Ramps are nearly identical to stairs in how they are created and represented. Like stairs, they have two implicit doors at either end and always take the shape of a rectangular piece of geometry. They also have very similar creation tools: the two-point ramp tool, ![two-point ramp tool](image), and the one-point ramp tool, ![one-point ramp tool](image). The key difference between ramps and stairs is that ramps do not affect the speed at which occupants travel.

**Elevators**

Pathfinder supports elevators in egress-mode operation, which is based on current thinking described in *Using Elevators In Fires*[^1]. The basic operation of elevators in evacuations can be summarized as follows:

- Each elevator has one *discharge* floor. This is where the elevator starts at the beginning of the simulation and where it will take occupants it has picked up.
- Each elevator has at least one *pickup* floor. These are floors where the elevator will pick up occupants that it will take to the *discharge* floor.
- An elevator is *called* on a pickup floor by an occupant when they come within .5 m of the elevator door.
- The elevator uses a priority system to serve *called* floors. By default, floors are served from top to bottom; however, other floors can be given higher priority to simulate fire floors.
- When travelling to a pickup floor, the elevator can change to another pickup floor mid-flight if a higher-priority floor is called that is above the elevator’s current location.

- Once an elevator has picked up occupants, it will only travel to the discharge floor before letting the occupants off. It will not travel to any other floor to pick up more occupants.

Creating Elevators

Elevators can be made after creating the rest of the model. Perform the following steps to create the elevator (refer to Figure 28):

1) Draw a room, preferably on the discharge floor, that defines the shape of the elevator.
2) Draw all doors on the boundary of the base room that occupants will use to enter and exit the elevator on every floor.
3) Right-click the base room, and from the right-click menu, select Create Elevator.... This will show the New Elevator dialog as shown in Figure 29.
4) In the New Elevator dialog, enter all parameters for the elevator:
   - Name – the name of the elevator
   - Nominal Load – the number of people in a full load (estimated). Please read the Nominal Load section below for details.
   - Elevator Geometry – the base room that defines the elevator shape. This defaults to the room that was originally selected.
   - Travel Direction – a vector defining the direction the elevator can travel. This vector will automatically be normalized. NOTE: the elevator can travel negatively against this vector.
   - Elevator Bounds – this defines the bottom-most and top-most floors the elevator can connect to.
   - Elevator Timing – this defines a basic timing model used to calculate the travel times for the elevator to travel from the discharge floor to each pickup floor.
   - Acceleration (Elevator Timing) – [optional] the acceleration of the elevator.
   - Max Velocity (Elevator Timing) – the maximum velocity that the elevator can accelerate to.
   - Open+Close Time (Elevator Timing) – the sum of the door opening and closing times. Each value will be taken as half of this.
5) Press OK to create the elevator.

If necessary, Pathfinder will automatically subtract holes in existing geometry to make space for the elevator shaft. It will also delete existing rooms, doors, stairs, and ramps in the elevator shaft. Pathfinder will ask before making any of these changes.

In order for occupants to use elevators, they must explicitly be told to do so through their behaviors, as discussed in Behaviors.

NOTE: The timing values can be re-calculated using a new timing model by selecting the elevator, selecting Edit... next to Level Data in the property panel, and then selecting Reset... in the level data dialog.
Figure 28: Creating an Elevator

Figure 29: New Elevator dialog
Elevator Representation
Once an elevator is created, it will appear in the model as a series of “rooms” and doors connected by a transparent elevator shaft as shown in Figure 30. There is one room and set of doors for each floor to which the elevator can connect. In the 3D and 2D Views, each room is shaped the same as the base room that created the elevator. In the Navigation View, each room is shown under the elevator rather than the Floors top node. In addition, each set of doors for the room is shown under the room. By default, each of the rooms is named after the floor on which it connects. If the elevator is disconnected completely from a floor as discussed in Connecting/Disconnecting Floors, the room is named “<Disconnected Level>”.

Figure 30: Elevator representation

Editing Elevators
Once an elevator is created, the elevator’s properties can be edited by first selecting it from the navigation view or by ALT-clicking one of its rooms from the 2D or 3D view. Its properties can be edited in the property panel as shown in Figure 31.

Figure 31: Elevator property panel

- **Nominal Load** – the number of people in a full elevator load (estimated). Please read the Nominal Load section below for details.
- **Open Delay** – the minimum amount of time an elevator’s doors will stay open on a pickup floor.
- **Close Delay** – the time between when the last occupant goes into the elevator on a pickup floor and the door closes.
- **Discharge Floor** – the floor at which occupants will discharge during an evacuation.
- **Floor Priority** – the priority of the floors for pickup. By default this is top-down. This can be changed, however by clicking the text, which will show the Floor Priority dialog as shown in Figure 32. This allows the simulation of a fire floor.

- **Level Data** – click the button to edit timing for each floor. This will open the Elevator Levels dialog as shown in Figure 33.
  - **Delay** – the time delay from the start of the simulation for when the elevator can start picking up occupants from a floor. This value does not affect the discharge floor.
  - **Open+Close Time** – the total of the door opening and closing time for this floor.
  - **Pickup Time** – the time for the elevator to travel from the discharge to the pickup floor.
  - **Discharge Time** – the time for the elevator to travel from the pickup to the discharge floor.
  - **Reset** – By selecting the Reset... option at the bottom of the dialog, an Elevator Timing dialog will open, allowing automated recalculation of the Level Data parameters. The timing options shown are the same as those shown when creating the elevator.

![Figure 32: Elevator Priority dialog](image)

![Figure 33: Elevator Levels dialog](image)

---

2 The pickup and discharge times are calculated from the timing parameters entered in the New Elevator dialog when the elevator is created.
**Nominal Load**
The nominal load is an estimate of the number of people that represent a full elevator load. The default value is based on an estimate of how many occupants of default size (diameter = 45.58 cm) would normally fill the elevator in steering mode. Increasing or decreasing the nominal load will cause occupants' sizes to be scaled up or down while they are on the elevator. The scale factor (default: 1.0) is determined by a correlation to the density produced by the nominal load. This makes it possible to adjust loading while still accounting for differences in individual occupants' size. In steering mode, the geometry of the elevator can lead to reduced loads (e.g. if the elevator is 2.8 persons wide). Please verify that the resulting (post-simulation) elevator loads match elevator manufacturer recommendations.

**Connecting/Disconnecting Floors**
When an elevator is created, by default it is connected to every floor its doors touch along the elevator shaft. Individual elevator doors can be disabled, however, to prevent entering/exiting the elevator through those doors on specific floors. To do so, right-click the elevator door on the desired floor from the Navigation View or 3D/2D View and select **Disable** from the right-click menu. To re-enable it, right-click the door from the Navigation View and select **Enable**. Alternatively, right-click an elevator level and select **Disable** to disconnect all doors on that level, effectively preventing the elevator from picking up occupants on that level.

**Exits**
In Pathfinder, exits are merely thin doors that exist on the boundary of the model. An exit can only have a room on one of its sides.

Exits are created in almost the same way as thin doors as discussed in the section, Thin Doors. The only difference is that the door must lie on an edge of a room, and the edge must not be shared between two rooms.

Exit doors are displayed the same as thin doors except that they are green as shown in Figure 34.
**Figure 34: An exit door**

**Importing Files**

Pathfinder can import a number of image and geometry files to aid in both drawing and automatically extracting rooms. This includes several image formats, DXF, DWG, FDS, and PyroSim files.

**Importing images**

Background images can be imported by clicking **Add a Background Image...** on the **Model** menu. When clicked, a dialog will appear prompting for an image file. The following image formats are currently supported:

- GIF
- JPG
- PNG

After a file is selected, a new dialog will appear as shown in Figure 35. This dialog allows properties of the image to be specified so that the proper scaling, rotation, and offset can be applied. To specify the scaling for the image, two points, A and B, and a distance between them can be specified. To specify the rotation of the image, an angle can be input that specifies the angle of the vector from A to B with the vector (1,0,0). As shown in the figure, the A->B vector should be 90 degrees from the X axis. The image will automatically be rotated when finished. Finally, an anchor point can be specified on the image that indicates where that point is located in 3D space.
Figure 35: Importing a background image

The imported image is added to the “Imported Geometry->Background Images” group in the Navigation View. The image can be edited and deleted from there. In addition, any number of images can be added to any floor.

Importing CAD files
Pathfinder can also fully import files saved in AutoCAD’s Drawing Exchange Format (DXF) as well drawing (DWG) files.

To import a DXF or DWG file, under the File menu, select Import... and select the desired file. After selecting a file, a step-by-step dialog will open as shown in Figure 36.

1. **Units**: The first prompt asks the user to select the base unit in which the CAD file was created. If the drawing was saved in a more recent file format, the prompt will default to the stored unit type. The dialog box shows the model’s width, depth, and height based on the selected unit as a guide for selecting the unit. Selecting Next brings up the options prompt.
2. **Options:** The options prompt allows the user to specify more options for import. Before this, Pathfinder will attempt to discern if the CAD file contains a 2D Floorplan or a 3D Model and will select default values for the options based on the detected type.

- **Lines** – check to import lines in the file (default=checked only for floorplans)
- **Faces** – check to import faces in the file (default=checked only for 3D models)
- **Move geometry to Z** – if checked, all imported geometry will be offset so that the minimum Z lies in the specified Z plane (default=checked only for 2d floorplans).
- **Flatten so geometry lies in one plane** – if checked, all geometry will be scaled in the Z dimension by a very small scale (1e-9). This is useful for floorplans that have entities drawn in several planes. This option will flatten them all into one plane. (default=checked only for 2d floorplans).
- **Add a blank rectangle to obscure lower floors** – if checked, a solid rectangle of the specified color will be added to the model. This is useful to obscure geometry located on lower floors. The imported rectangle will be excluded from floor extraction by default. (default=checked only for 2d floorplans).

![Figure 36: Dxf unit dialog box](image)

Choose **Finish** to import the file. All imported elements will be added to the “Imported Geometry” node in the Navigation View. The grouping structure will include the model level, the layer level, and all entities distributed within the layer. If both lines and faces were included in import and an entity contained both lines and faces in the CAD file, the entity is split into two in Pathfinder - one with the lines, and one with the faces.

**NOTE:** In versions prior to Pathfinder 2012.1, DXF import allowed a background image to be created that could be passed through to the 3D results viewer. While this option is no longer available, both imported line and face data is now sent directly to the 3D results viewer instead, eliminating the need for a background image.
Importing PyroSim and FDS files
Both PyroSim and FDS files can be imported into Pathfinder. To import one of these file types, select Import... under the File menu. Then select the appropriate FDS or PSM file. The imported geometry will be added to the Imported Geometry group.

If the imported file contains holes, the holes will be automatically subtracted from the solid obstructions and discarded. If the file contains grids, the grids will be intersected with each other as FDS would, and the remaining minimum Z faces of the grids will be imported. If the file contains OPEN vents, the vents will be subtracted from the appropriate grid faces and discarded.

Working with Imported Data
Each type of file that can be imported provides an aid for creating navigation geometry. The different types can be worked with in various ways to create the desired rooms, stairs, and doors. Common to all import types is the ability to set the color and opacity for each component of the geometry. The imported geometry is sent as-is to 3D Results, resulting in a clean and fast graphical representation of the data.

Working with Images
Working with background images requires the user to draw all rooms, doors, and stairs over the background image. Because the drawn navigation geometry will cover the background image, it may be preferable to make the navigation geometry transparent. This can be accomplished by selecting the drawn navigation components and lowering the opacity in the property panel. Figure 37 shows a background image with rooms and doors drawn on top, with a lowered opacity for the drawn rooms.

![Figure 37: Drawing rooms over a background image](image)

To draw rooms on top of a background image, refer to the section, Rooms on page 14.

Working with 3D CAD, PyroSim, and FDS files
Because 3D CAD, PyroSim and FDS files import 3D data, they provide the most helpful information for accurately extracting navigation area. Navigation area can be extracted on a room by room basis using the Extract floors tool (epad) from the 3D or 2D views.
The tool properties for this tool are shown in Figure 38. The **Max Slope** refers to the maximum grade that a person can walk on. Only imported polygons that have a slope less than this will be included in the result. **Max Head Height** refers to the maximum height of all the agents that will be included in the simulation. This parameter is used to subtract overhead obstructions from the resulting room. The **Gap Tolerance** provides some control in dealing with imperfections in the imported data. If walls are closer than the gap tolerance, Pathfinder will add an extra thin wall in that area, helping to split of rooms so the result does not bleed into undesired areas.

![Property panel for the floor extraction tool](image)

**Figure 38: Property panel for the floor extraction tool**

To extract a room using this tool, first select the tool from the 2D or 3D view. Once the appropriate parameters have been chosen, either enter a location on the floor of the desired room into the property panel or click this point in the 3D or 2D view. If this point does not have any overhead obstructions within **Max Head Height** and the point is on a polygon with a slope less than **Max Slope**, Pathfinder will march out from this point on the imported geometry’s polygons until it finds the boundaries of the room. It will also subtract overhead obstructions within **Max Head Height** from the resulting room. An example of an extracted room is shown in Figure 39.

![A room extracted from a PyroSim file](image)

**Figure 39: A room extracted from a PyroSim file**

When using the 3D floor extraction tool, Pathfinder will include all imported geometry with faces, even if hidden. If an object must be excluded from floor extraction, before performing extraction select the imported object and in the property panel, deselect **Include in room extraction**.

**Working with 2D DXFs**

2D DXF data can be worked with in two ways: it can be used as a guide for drawing rooms similarly to background images with the added benefit of being snapped to, or it can have rooms automatically extracted from it similarly to 3D imported geometry.
To sketch the rooms using the built in drawing tools, refer to the section, Rooms on page 14.

Automatic room extraction from 2D DXF data works similarly to extracting rooms from 3D DXF data. As in 3D extraction, the Extract floors tool (️) is used. In addition, the user must click a point in the model with the tool, and one room will be automatically extracted. The main difference from 3D extraction is that the clicked point must not lie on any 3D imported faces marked for floor extraction; instead it must be in empty space (or on the background rectangle imported with a 2d floorplan). The clicked point should also be surrounded by imported 2D lines. These lines will form the boundary of the resulting room. For this reason, any lines that do not contribute to the room’s boundary, such as notations, symbols, etc. should be deleted, hidden, or excluded from floor extraction prior to clicking the extraction point. To manually exclude imported geometry from floor extraction, select the geometry and from the property panel, deselect Include in room extraction. When determining which imported geometry to extract rooms from, the 2d room extraction tool will automatically exclude hidden objects and those manually excluded.

Once the desired point is clicked, the surrounding 2D lines looking at the model from the Top View will be projected along the Z axis onto the active floor’s working Z plane. These projected lines will then be used to define the room around the clicked point. If the surrounding lines do not form a closed boundary as shown in Figure 40 (a), the resulting room will spill outside of the lines and form a room around the bounding box of all the lines as shown in Figure 40 (b). In this case, this outer portion of the room can be separated from the inner portion using the Thin Wall tool as discussed in the section, Adding thin walls to rooms. Once separated, the outer portion can be deleted.

When the extraction tool is finished finding a room, the room will lie in the working Z plane of the active floor.

![Figure 40: Room extraction results from an imported 2D Floorplan](image)
Filling in missing pieces
Once rooms have been extracted using the 3D or 2D room extraction tools, the model will still be missing doors and stairs. Doors and stairs must be added manually as discussed in the appropriate sections of this guide.

One feature that may be of particular interest to help this process, however, is the internal door feature of the door tool. This feature automatically finds areas within a room that look like potential doorways and can be used to create a thick door in this area. To use this feature, select the door tool. In the property panel for the tool as shown in Figure 20, the Max Width refers to the maximum width of the doorway to search for and Max Depth refers to the maximum thickness of the doorway. These numbers may need to be larger than for the normal creation of a door to find potential doorways. Once the appropriate parameters have been entered, move the cursor over the desired doorway. A door preview will be displayed. If it doesn’t, adjust the search parameters in the property panel and try again. If the door appears correctly, left click the mouse button. The doorway area of the room will be subtracted from the room, and the thick door will be created in its place. The process is shown in Figure 41.

![Figure 41: Using the door tool to fill a doorway](image-url)
4. Creating Occupants

In Pathfinder, occupants are composed of two parts: profiles and behaviors. The profile defines characteristics of the occupants, such as speed, radius, avatar, and color. The behavior defines a sequence of actions the occupant will take throughout the simulation, such as moving to a refuge area, waiting, and then exiting.

Profiles

Pathfinder uses an occupant profile system to manage distributions of parameters across groups of occupants. This system helps you control the occupant speed, size, and visual distributions. To edit occupant profiles, you can use the Edit Profiles dialog (Figure 42).

To open the Edit Profiles dialog: on the Model menu, click Edit Profiles...

The Description box provides a place to enter descriptive text. This value is not used outside the Edit Profiles dialog.

The 3D Model input provides a way to use a specific set of 3D human models for an occupant profile. To select 3D models, click Edit... on the 3D Model row. This will open the 3D Models dialog (see Figure 43). When rendering occupants as 3D human models belonging to the current profile, Pathfinder will choose one of the 3D models selected in the 3D Model dialog. To enable or disable a particular model, click the model's icon.
The Characteristics tab provides the following parameters:

- **Priority Level** – the priority of the occupant. Higher values indicate higher priority. This allows occupants of lower priority to move out of the way of those of higher priority. This would be useful when simulating first responders that must be able to move easily through a crowd of occupants. Priority values are completely relative. For instance, if three occupants meet of priorities 4, 6, and 12, they will behave the same as if their priorities were 0, 1, and 2, respectively.
- **Speed** – specifies the maximum speed an occupant may travel in an open room.
- **Shoulder Width** - the diameter of the cylinder representing the occupant. This is used for collision testing and path planning during the simulation. This value will also affect how many occupants can be added to a room without overlapping.

The Advanced tab provides the following parameters:

- **Height** – the height of the cylinder used for inter-occupant collisions. This is useful for limiting collisions that might occur between occupants on different floors when the floors have been modeled close together.
- **Reduction Factor** - a Steering Mode Parameter that specifies how well an occupant may squeeze past others in tight corridors. This factor should be specified as greater than 0 and less than or equal to 1. This factor is directly multiplied by the shoulder width during calculations, so a Reduction Factor of 0.5 would lead to the occupant being able to squeeze to one-half his shoulder width.
- **Comfort Distance** - specifies the desired distance one occupant will try to maintain with others nearby such as when waiting in queues.
• **Persist Time** – The amount of time an occupant will maintain an elevated priority when trying to resolve movement conflicts. See the Technical Reference for more details.

• **Collision Response Time** – when multiplied by an occupant’s current speed, this parameter controls the distance at which an occupant will start recording a cost for colliding with other occupants when steering.

• **Slow Factor** - specifies a fraction of the occupant’s speed at which they are considered to be slow. A slow occupant will consider backward directions to separate with others, while a fast moving occupant has a tighter, more focused direction.

Each of these parameters can be set using a **constant** value, a **uniform distribution** between two values, or either a **normal** (Gaussian) or **log-normal distribution** using a min, max, standard deviation, and mean.

Each occupant in the Pathfinder model is linked to one profile. Profile parameters can be edited in the profiles dialog at any time and the occupants using that profile will be automatically updated. Occupants’ profiles can be set when adding the occupants or by selecting the occupants after being created and editing the **Profile** box in the property panel.

**Seeds**

Each occupant has a unique random seed that determines the specific values generated from a profile distribution. Each of these occupant-specific values can be seen by selecting an individual occupant. These specific values will never change unless the distribution is changed in the profile or a new seed is manually generated for the occupant. This ensures that two simulation runs with the same input model will give the same answer. New seeds can be generated for occupants by right-clicking the occupants and selecting **Randomize**.

For an example of the effects of the changing the seed or profile, consider the following scenario:

1. A profile has been created using a uniform distribution of speed on the range 1 m/s to 2 m/s.
2. An occupant is created using this profile.
3. Using the occupant’s unique random seed, Pathfinder assigns the occupant a speed of 1.6 m/s based on the occupant’s profile.
4. The simulation is run several times, and each time the occupant has a maximum speed of 1.6 m/s.
5. The occupant’s profile is changed so that its speed range is .5 m/s to 1 m/s.
6. Pathfinder assigns the occupant a new maximum speed of .6 m/s, which is used for all subsequent simulations.
7. The user randomizes the occupant, and Pathfinder assigns a new maximum speed of .91 m/s to the occupant.
**Customizing Occupants**
When occupants are selected, their property panel appears as shown in Figure 44. Occupants can be given custom profile data once they are added to the model. This can be done by selecting a set of occupants and checking the box next to the parameter to be customized.  

When using custom profile data, only constant values can be used for occupant parameters. In addition, once a parameter is customized, any changes to that parameter in the profile will not affect the customized value.

![Figure 44: Using a custom occupant profile](image)

**Behaviors**
Behaviors in Pathfinder represent a sequence of actions the occupant will take throughout the simulation. For every behavior, there is an implicit action to move the occupant to an exit. This implicit action will always happen last. Additional intermediate actions may also be added that can make the occupant wait or travel to a non-exit destination, such as a room or point. By default, there is one behavior in the model called “Goto Any Exit.” This behavior simply makes the occupant move from their starting position to any exit present in the model by the fastest route.

As with profiles, any number of occupants can refer to a single behavior. Any changes to the behavior will be reflected in referring occupants.

**Creating a new Behavior**
To create a new behavior, right click the Behaviors node from the Navigation View, and from the right-click menu, click Add a Behavior..., which will open the New Behavior dialog shown in Figure 45. In the New Behavior dialog, enter a behavior name, and optionally specify an existing behavior to base the new behavior on. Using this option will copy all the actions from the existing behavior.

---

3 In versions of Pathfinder prior to 2012.1, individual parameters could not be customized. If one parameter was to be customized, all had to be customized.
With the new behavior selected, the behavior property panel will appear as shown in Figure 46.

- **Initial Delay** – This specifies an initial delay that makes the occupant wait at their starting position before moving to the next action. If this link is clicked, it will show a dialog where different distribution curves can be entered for the delay, similar to those discussed in Profiles.
- **Exits** – This specifies a set of exit doors the occupant is allowed to exit through during their final implicit exit action. Clicking this link will open the exit chooser, as shown in Figure 47.

**Figure 46: Behavior Property Panel**

**Figure 47: Exit Chooser dialog**

**Adding actions**

Additional actions can be added to any behavior, such as going to a room, a waypoint, an elevator, or simply waiting in place. To add an action, select a behavior or existing behavior action. The property panel (Figure 46) will show a drop-down button with the description of an action that can be added. To add the currently shown action, simply click the button. To add a different action, click the down-arrow shown to the right of the button and select the desired action from the *behavior actions list*. 
Once the desired action is clicked, a creation panel will be shown above the 3D/2D View depending on the action. Enter the desired parameters in the creation panel as discussed in the following sections, and then click **Create** to create the action and append it to the behavior. If the behavior itself was selected when adding the action, then the new action will be appended to the end of the list. If, instead, an action was selected when the new action was created, then the new action is inserted directly after that selected action.

Actions always occur in the order shown in the Navigation View. For instance, as shown in Figure 49, an occupant using “Behavior1” would first go to any elevator, then go to “Room00”, then wait for 20 seconds, then go to “Room09”, and finally exit. The actions can be reordered at any time (except exiting) by dragging and dropping an action in the list in the Navigation View.

**Goto Waypoint action**

A *Goto Waypoint* action specifies that an occupant should go toward a specific point on the navigation mesh. Once they arrive within a certain radius of the point, they will move on to the next action in their behavior.

To add one of these actions, click the **Add Goto Waypoint**… button from the *behavior actions list*. When adding the waypoint, the creation panel will look like Figure 50. The **Location** specifies where the occupant must head. This must be a point on the navigation mesh. The **Arrival Radius** defines a circular area around the point. These parameters can be entered manually in the creation panel or be filled in by clicking a point on the navigation mesh in the 3D or 2D View or click-dragging to specify the location+arrival radius. When clicking or click-dragging, the action is created when the mouse button is released.
Goto Rooms action
A **Goto Rooms** action specifies that an occupant must select a room out of a set, and go to it. Once they cross a door into the room, they are considered to be in the room and can move on to the next action in their behavior. If multiple rooms are specified for the action, the occupant will go to the one that is fastest for him to reach.

To add a **Goto Rooms** action, click the **Add Goto Rooms**... button from the *behavior actions list*. The creation panel will appear as in Figure 51. Either click the **Rooms** link to specify the rooms with a dialog or left-click the desired rooms in the 3D or 2D View. Right-click in the 3D/2D View to finish selecting the rooms and create the action, or click **Create**.

Goto Elevators action
A **Goto Elevators** action tells an occupant to use evacuation elevators. When using this action, an occupant will go to a specified elevator, call it, wait for it to arrive, enter it, and then wait for it to reach the discharge floor. Once they reach the discharge floor, they can begin their next action. The **Goto Elevators** action can only be used for occupants who are not on the discharge floor of the desired elevator. If multiple elevators are specified for the action, the occupant will use the one that allows them to reach the discharge floor fastest.

To add a **Goto Elevators** action, click the **Add Goto Elevators**... button from the *behavior actions list*. The creation panel will appear as in Figure 52. Either click the **Elevators** link to specify the desired elevators with a dialog or left-click the desired elevators in the 3D or 2D View. Right-click in the 3D/2D View to finish selecting the elevators and create the action, or click **Create**.
**Wait action**

A *Wait* action tells an occupant to wait in their current location for a certain amount of time. Once that time has elapsed they will begin their next action.

The manner in which they wait will vary depending on their most recent destination. For instance, if their previous destination was a waypoint, they will try to stay close to the center of the waypoint. If the previous destination was a room, they will try to move toward a wall of the room, away from all doors. This allows other occupants to enter the room. If their previous destination is an elevator, they will first move toward the walls as in waiting in a room, and then stand still when the elevator travels. In all cases, a waiting occupant will move out of the way of occupants headed toward a destination unless the destination overlaps with the waiting occupant’s most recent destination.

To add a *Wait* action, click **Add Wait** from the *behavior actions list*. The creation panel is shown in Figure 53. The **Wait Time** specifies the amount of time they will wait at their current location.

![Figure 53: Wait creation panel](image)

**Adding Occupants**

Occupants can be placed individually in the 3D or 2D view, distributed in a rectangular region of a particular room, or distributed through the entire area of a room or multiple rooms.

**Individual placement**

Individual occupants can be added to the model with the Add Occupant tool, ![Add Occupant](image). Occupants can only be placed in pre-existing rooms and stairs and cannot overlap other occupants or room boundaries. Left-click a desired position with the mouse, or enter an x-y-z coordinate and press the Create button from the property panel to place an occupant.

![Figure 54: Adding occupants individually](image)
Group Placement

Groups of occupants can be added to the model with the Add Occupant Group tool ( ). The occupants are distributed throughout this region using parameters in the property panel as shown in Figure 55:

- **Random/Uniform Placement:** Random placement places occupants randomly within the designated area, such that no overlapping of occupants occurs. If the number of desired occupants is too great to accomplish this, a prompt will ask whether or not to continue with overlapping occupants. Uniform placement places occupants in an orderly hex pattern, allowing greater occupant densities before overlap occurs. Again, a prompt will ask whether to continue with overlap if the density is too great.

- **Count/Density:** This option specifies whether to place a set number of occupants or place enough occupants to achieve a certain density. Several template densities are provided, and Custom can be selected from the densities drop-down menu to enter a new value.

- **Profile:** This option allows a distribution of profiles to be set for the occupants, such as specifying that 25% of the added occupants should be females < 30 years old, 30% children, etc. The label shows the currently set distribution, and if there is more than one profile defined in the model, the value can be clicked to edit the distribution. This will open a dialog as shown in Figure 56.

- **Behavior:** Like the Profile option, this option allows the distribution of behaviors to be set.

![Figure 55: Add Rectangular Group of Occupants Property Panel](image)

![Figure 56: Editing the distribution of profiles](image)

Once the properties have been set, click-drag to draw the filling rectangle. Both points of the rectangle must lie in the same room.
When any occupants are selected, the property panel allows the occupants’ name, profile, behavior, and color to be edited. The occupants’ speed, time delay, and size are also displayed from the occupant’s profile, and can be made editable by selecting Custom from the profile drop-down menu.

Placement in rooms
In addition to distributing occupants in placement regions, occupants can be distributed throughout entire rooms. To do this, select the desired rooms and choose Add Occupants... from the Model menu or the right-click menu as shown in Figure 58. This will bring up the Add Occupants dialog. For an explanation of the dialog’s options, please see the section, Group Placement. Click the OK button after selecting the desired options to place occupants and exit the dialog.

Redistributing Profiles and Behaviors
Once occupants have been created, the distribution of profiles and behaviors can be reshuffled among them. To do so, select one or more groups of occupants from the Navigation View, right-click them, and from the right-click menu, select Properties..., or double-click the occupants group. The Edit Group Distributions dialog will appear as shown in Figure 59. If more than one profile exists in the model, the
Profile link can be clicked to edit the distribution as discussed in Group Placement. If more than one behavior exists in the model, the Behavior link can be clicked to edit its distribution.

NOTE: Changing the distribution of profiles or behaviors will not change the number of occupants in the group. It will just change which profile/behavior is assigned to each occupant to match the specified distribution as closely as possible.

Figure 59: Edit Group Distributions dialog
5. Editing and Copying Objects

Most objects can be edited in two ways in Pathfinder. One way is to **transform** the object, including rotating, translating (moving), and mirroring it. Another way is to graphically **manipulate** the objects by dragging **handles**. Objects can also be copied, but currently the only way to do this is through the transform tools as discussed in the following section.

Transforming and Copying Objects

All geometric objects can be transformed and/or copied. All transform/copy options are available through tools in the 3D and 2D views. The following transforms are available and are discussed in the following sections: moving, rotating, and mirroring.

**Moving**

To move one or more objects, select the objects and click the move tool ( draggable object) from the 2D or 3D view. The property panel for the move tool is shown in Figure 60.

![Property panel for the translate tool](image)

The object can be moved either manually or graphically:

- **Manually**: Select **Normal Mode** and enter the distance to offset the object in the Move X, Y, and Z boxes. Then click **Move**.
- **Graphically**: This is performed most easily in one of the 2D views. To translate graphically click two points on the model. The vector from the first point to the second defines the movement offset. When moving graphically, objects will only be moved parallel to the camera’s view plane. The steps for translating graphically are shown in Figure 61.
Objects can also be copied using the move tool. To do so, select the move tool, select **Copy Mode** from the property panel, and follow the same steps as above for moving an object. Alternatively, hold CTRL on the keyboard while defining the offset. This will create a copy of the object that has been offset by the move distance. Similarly, an array of objects can be made by specifying a value greater than 1 for the **Copies** field in the property panel. The array is created by offsetting each previous copy by the move distance. If, when copying rooms, the resulting copies overlap one another the most recent copies take precedence over earlier ones, meaning that earlier ones will have area subtracted from them. An array is shown in Figure 62.

**Rotating**

To rotate one or more objects, select the objects and click the rotate tool (ائه) from the 2D or 3D view. The property panel for the rotate tool is shown in Figure 63.
The object can be rotated either manually or graphically:

- **Manually**: Select **Normal Mode** and enter the base of rotation, the axis about which to rotate using the right-hand rule, and the angle to rotate. Then click **Rotate**.

- **Graphically**: This is performed most easily in one of the 2D views. The rotate axis is automatically set to a vector normal to the camera. Rotating requires three mouse clicks. The first specifies the base of rotation. The second defines a reference vector extending from the rotation base. The third defines a second vector extending from the rotation base. The rotation angle is the angle between these two vectors. The steps for rotating graphically are shown in Figure 64.

![Figure 63: Property panel for the rotate tool](image)

![Figure 64: Rotating an object](image)
Objects can also be copied using the rotate tool. To do so, select the rotate tool, select **Copy Mode** from the property panel, and follow the same steps as above for rotating an object. Alternatively, hold CTRL on the keyboard while defining the rotate properties. This will create a copy of the object that has been rotated from the original using the rotate parameters. Similarly, an array of objects can be made by specifying a value greater than 1 for the **Copies** field in the property panel. The array is created by rotating each previous copy by the rotate angle. If copying rooms and resulting copies overlap one another the most recent copies take precedence over earlier ones, meaning that earlier ones will have area subtracted from them. An array is shown in Figure 65.

![Figure 65: Creating an array of objects using the rotate tool](image)

**Mirroring**

To mirror one or more objects about a plane, select the objects and click the mirror tool ( ![mirror tool](image)) from the 2D or 3D view. The property panel for the mirror tool is shown in Figure 66.

![Figure 66: Property panel for the mirror tool](image)

The object can be mirrored either manually or graphically:

- **Manually**: Select **Normal Mode** and enter the plane about which to mirror. This can be an axis-aligned plane or a custom plane specified by the plane equation, \( ax + by + cy + d = 0 \). Next click **Mirror**.
- **Graphically**: This is performed most easily in one of the 2D views. The mirror plane is always perpendicular to the camera’s view plane. Defining the plane requires two mouse clicks that define two points in the plane. The steps for mirroring graphically are shown in Figure 67.
Objects can also be copied using the mirror tool. To do so, select the mirror tool, select **Copy Mode** from the property panel, and follow the same steps as above for mirroring an object. Alternatively, hold CTRL on the keyboard while defining the mirror plane. This will create a copy of the object that has been mirrored from the original using the mirror plane.

**Manipulating Objects with Handles**

Some objects, including occupants, rooms, stairs, and doors, can be edited through manipulator **handles**. **Handles** act as points on an object that can either be dragged with the selection tool or edited by the keyboard to edit the attached object. Handles only appear on selected objects and show as blue dots as shown in Figure 68.

![Manipulator handles](image)

**Figure 68: Manipulator handles**

**Selecting and deselecting a handle**

To select an object’s handle, the object itself must first be selected. Once it is selected, the blue handles should appear. Next select the **Select/Edit** tool ( ). Now an individual handle can be selected by clicking it, which will make the handle property panel appear as shown in Figure 69. To deselect the handle, press Escape on the keyboard, click anywhere else in the model, or select another object.
Editing a handle
A handle can be edited in one of two ways: it can be edited with the keyboard to enter precise values or it can be edited graphically.

- **Editing with the keyboard**: to edit with the keyboard, a handle must first be selected. Next enter the desired location in the X, Y, and Z fields in the property panel and select the **Commit** button. The handle will attempt to modify the underlying object using the handle’s internal constraints that are described in the appropriate section of this guide for the respective handle’s object.

- **Editing graphically**: a handle does not have to be selected before editing graphically. To edit graphically, make sure the **Select/Edit** tool is selected, and press the left mouse button over the desired handle and drag the handle to the desired location. Release the left mouse button, and the object will be edited. A real-time preview of the object being edited will be shown as the mouse is dragged.

**Room handles**
When rooms are selected, a handle can be found at every vertex on the boundary of the room. The handles move the underlying vertex to reshape the room. The handles can be moved to any location within the plane of the face the vertex is on. If the vertex is shared between two faces in non-parallel planes, the handle can only be moved along the edge to which it is attached.

**Thin door handles**
When a thin door is selected, three handles will be displayed as shown in Figure 70 (a). The handles on the ends of the door allow the door to be moved along the edge to which it is attached. The middle handle allows the door to be made thick by moving the handle to the edge of another room as shown in Figure 70 (b).

Figure 69: Handle property panel

Figure 70: Door handles
**Thick door handles**
When a thick door is selected, six handles will be displayed as shown in Figure 70 (b). The four handles on the corners of the door allow the door to be moved along the edge to which each handle is attached. Each middle handle allows the door to be made into a thin door by dragging to the other middle handle. The middle handle can also be useful to reattach the door to a room if the door somehow became detached (such as by a modification to the room).

**Stair and Ramp handles**
When a stair or ramp is selected, six handles will be displayed as shown in Figure 71. The four corner handles each allow the stair/ramp to be moved along the edge to which the handle is attached. The middle handles allow the stair/ramp to be reconnected to another room. The middle handles can also be useful if the geometry of one room attached to a stair/ramp has changed in such a way that the stair/ramp is no longer attached to the room. The middle handle can be used in this case to reconnect to the room.

![Stair/ramp handles](image)

**Figure 71: Stair/ramp handles**

**Occupant handles**
When an occupant is selected, there is only one handle as shown in Figure 72. The sole purpose of this handle is to move the agent to another location. Moving an agent in this manner has a benefit over the translation tool in that the location automatically snaps to an existing room or stair as when adding an agent using the agent dropper tool.

![Agent handles](image)

**Figure 72: Agent handles**
Waypoint handles
When a waypoint is selected, five handles are displayed as shown in Figure 73. The center handle allows the waypoint to be moved to another location similarly to the occupant handle. The four handles on the perimeter of the circle can be used to change the arrival radius of the waypoint.

Figure 73: Waypoint handles
6. Model Analysis
Pathfinder contains some useful tools to analyze various properties of a model.

Measuring Distances
Distances can be measured by using the measuring tool ( ). To do so, select the measuring tool from the 3D or 2D view. Left-click a series of points to define a path along which to measure a distance. When done defining points, right-click. The cumulative point-to-point distance is displayed in a dialog box.

When measuring distances in the 3D view, the distance is taken as the actual distance between snapped points. When measuring distances in the 2D view, however, the distance is taken by projecting the points onto a plane parallel to the camera view plane, and then taking the distance.

Checking Connectivity
Sometimes it is desirable to check how various components are connected in the model to debug simulation errors or to ensure model validity. For instance, a model might contain two rooms connected by a hallway as shown in Figure 74.

![Figure 74: Connectivity example]
If a user attempts to simulate this model, the following error appears:
This type of error usually indicates that the model is not properly connected. It is telling us that the occupant named “00001” cannot reach any of their assigned exits. This means that either a connecting door is missing along their route to the exit or some other problem has occurred with the geometry. We need to determine why the occupant cannot reach the exit on the right side of the model. To do so, we right-click the room containing the occupant, and click **Select Connected Components** from the right-click menu. The following dialog is shown:

**Figure 75: Select Connected Components dialog**

We want to trace model connectivity as far as possible to determine where we might be missing a door or other connection, so from the drop-down box in the Select Connected Components dialog, we choose **Entire graph** and click **OK**. Pathfinder will highlight the entire graph of components touching the initial selection as shown in Figure 76.
Figure 76: Selecting an entire graph of connected components

From the selection, we can see that the hallway does not connect to the far-right room. Upon further inspection, we can see that we do not have a door between the hallway and the room. We can add a door to fix the problem.

From the Select Connected Components dialog, we could have also chosen to select only immediately adjacent components. This would have only selected the original room and the door between the room and the hallway. This allows finer inspection of connectivity in a highly connected model.

Checking in-use Objects

In Pathfinder, there are several objects that can refer to other objects in the model. For instance, an occupant can refer to both a profile and a behavior, a behavior can refer to exits, the goto elevators action can refer to elevators, etc. There are times when it is useful to know what objects are referring to another. For instance, it may be important to know which occupants are using a particular behavior. To do this, right click the behavior (or other in-use object), and from the right-click menu, click Select Referencing Objects. This will highlight all objects currently using that behavior.

Warnings and Errors

Pathfinder shows warnings and errors in the Navigation Tree to help debug potential errors in the simulation. These warnings appear as a small exclamation mark imposed over an occupant or record, 🚨. By hovering the mouse over the warning, a more detailed description of the problem can be determined. For convenience, if an object has problems, the warning marker is propagated up through the navigation tree to its ancestor groups in order to quickly identify problems in the model. Some common warnings include:

- Warning if stairs are not connected to rooms at both ends.
- Warning if stairs or doors overlap along an edge.
• Warning if stairs or doors create a non-manifold topology (e.g. a stair connects to the inside of a room rather than an outer wall or connects to two rooms on one of its ends).

Problematic objects can be quickly selected by right clicking a group in the tree that has a warning or error icon, and selecting Select invalid objects from the right-click menu. In addition, if the warning on a component indicates that it interferes or overlaps with other components, the objects with which it interferes can be quickly selecting by right-clicking the object with the warning and selecting Select conflicting components from the right-click menu.

As a general note, if the warning “Edge is adjacent to more than 2 triangles” appears when simulating, an option to click Cancel appears to highlight the navigation components causing the warning.
7. Simulating

Parameters

The Simulation Parameters dialog (shown in Figure 77) provides a way to control certain features of the simulation.

![Simulation Parameters Dialog](image)

**Figure 77: The Behavior tab of the Simulation Parameters Dialog**

The **Time** tab provides the following options:

- **Time Limit**: can be used to automatically stop the simulation after a set simulation time.

- **Time Step Size**: controls the resolution of simulation time steps. Increase the time step size to speed up simulations, reduce the time step size to ensure simulation accuracy.

The **Output** tab provides the following options:

- **3D Output Freq**: controls the time between 3D output file updates. Increasing this value causes data to be written less often, leading to less disk usage and run faster simulations (no file write delay), but can produce a misleading 3D results visualization. In the 3D results visualization, occupants will move in a straight line between two data points - if the two points are far apart in time, an occupant might appear to pass through an obstruction when it actually navigated properly.

- **CSV Output Freq**: controls the time between CSV output file updates. Increasing the value causes fewer rows to appear in the resulting CSV files (i.e. lower data resolution). This option has a negligible effect on simulation performance or disk usage.

- **Runtime Output Freq**: controls the time between simulation status updates in the Run Simulation dialog. This option has a negligible effect on simulation performance or disk usage.
The **Paths** tab provides the following options:

**Max Agent Radius Trim Error**: this parameter affects how accurately occupants can navigate through tight spaces when the occupants in the simulation have varying sizes. The larger this value is the less likely an occupant is to navigate through a space that has a width close to their body diameter. With larger values, however, the simulation will consume less memory and start faster (sometimes much faster if every occupant has a different size). Each occupant is guaranteed to be able to fit through a space with width equal to the occupant’s diameter plus twice this value.

**Constrain Edge Length**: controls the triangulation algorithm used to convert the rooms, stairways, etc. into the triangulated mesh used by the simulator. By default, Pathfinder attempts to generate the fewest and largest possible triangles and this approach works well with Pathfinder’s search algorithms. However, in some situations, "well behaved" triangles can be useful (e.g. to prevent extremely long, thin triangles). This value can be used to "fatten" these triangles. The Max Edge Length parameter controls the maximum length of any single edge on a room boundary, and the Min Angle criteria prevents the system from using triangles with any very small (i.e. thin) angles. Using Min Angle values greater than 30 degrees can cause Pathfinder to "freeze" when it attempts to generate a simulation input file.

The **Behavior** tab allows you to set options for Pathfinder's two primary simulation modes: **SFPE** and **Steering**. The SFPE mode uses the set of assumptions presented in the SFPE Handbook of Fire Protection Engineering and can give answers extremely similar to these hand calculations (depending on selected assumptions). In SFPE simulations, the mechanism that controls simulation movement is the door queue. The Steering mode is more dependent on collision avoidance and occupant interaction for the final answer and often gives answers more similar to experimental data than the SFPE mode (i.e. steering mode often reports faster evacuation times). Door queues are not explicitly used in Steering mode, though they do form naturally. The SFPE mode uses a simpler set of assumptions and usually completes much faster than a comparable steering mode simulation - in terms of CPU time.

To select a simulation mode, use the **Behavior Mode** box. The SFPE mode supports the following options:

**Add Basic Collisions**: can be activated to give the simulation a more realistic-looking appearance during results visualization. This option is disabled by default to more closely match the assumptions in the SFPE mode which allow only room density to affect the speed of occupants as they move toward the exits. The effect of this option on the overall evacuation time is usually negligible - blocked occupants can usually make it to a door before the door will allow them to pass through. Occupants that have not yet started moving (t < delay) and occupants traveling to different exits, will not be considered for collision handling and will interpenetrate if their paths cross.

**Max Room Density**: controls the density at which doors will no longer admit occupants into a room. Using an artificially low value for this number will give faster evacuation times. Using a
higher number 3.6 - 3.8 can cause extremely slow evacuation times. Using values above 3.8 pers/m² can cause the simulation to get stuck due to the density dependent velocity calculation.

**Door Boundary Layer**: is a global setting for boundary layer used only by the SFPE, Flow-based simulation mode. Door flow rates in this mode are calculated based on door width. This value is applied to both sides of a door to calculate the door width for the flow rate equation. For example, with a Door Boundary Layer setting of 150 mm, a 1.0 m door would be reduced to a 0.7 m opening giving an $F_{s_{\text{max}}}$ of $(1.32 \text{ pers/s-m} \times 0.7 \text{ m}) = 0.924 \text{ pers/s}$.

**Door Flow Rate** is a global setting for the algorithm used to calculate door flow rate. By default, the door flow rate calculation uses the max flow calculation $(1.32 \text{ pers/s-m} \times W_e)$. By activating the Calculate From Density option, the delay imposed by the door on the next occupant passing through, will be governed by the density of the originating room of the last occupant to pass through the door at the moment that occupant exited the queue. The Min Density and Max Density options allow you to bound the densities used in that calculation. This technique often leads to more conservative answers, but is not necessarily consistent with the assumptions presented in the SFPE Guide to Fire Protection Engineering.

The **Steering** mode supports the following options:

- **Collision Handling** behaves just like in SFPE mode except this is on by default for Reactive Steering
- **Inertia** forces occupants to ramp up to their maximum speed and down to a stop.
- **Steering update interval** specifies how often (in simulation time) to update the steering calculation. This could also be considered to be the cognitive response time of each occupant. The higher this number, the faster the simulation will run, as long as the simulation time step is less, but the poorer the decision making skills of each occupant will be.

### Starting and Managing a Simulation

To run a simulation: on the Model menu, click Run Simulation... ( ). The simulation will begin and the Run Simulation dialog (shown in Figure 78) will appear.
In this dialog, the abbreviation DTG stands for distance to goal. The maximum distance to goal represents distance to goal for the occupant farthest from its goal. The average distance to goal is the average of all occupants' distances to their respective goals.

The Debug button launches a runtime visualization that shows the progress of the simulation as it is taking place. This function is different from the Results button which launches the 3D visualization view for simulation results.

A simulation can also be paused, resumed, and cancelled at any time.

**Simulating via command-line**

Simulations can also be run through the command-line without loading the user interface. To do so, open a command prompt. Run “testsim.bat” located in the Pathfinder install folder. The only argument is the input .txt file generated by Pathfinder. Pathfinder automatically creates this file when performing a simulation through the user interface. The input file can be manually created in the user interface by going to the File menu and selecting Save Simulator Input. When running a simulation this way, it may also be desirable to manually create the geometry file for visualization. To do this, from the File menu choose Save Imported Geometry File.

NOTE: Running a simulation through the command line will not provide a management dialog through which the simulation can be paused and resumed.

**Stopping and Resuming a Simulation**

When running a simulation, there is the option to pause and resume, but this requires Pathfinder to be running the entire time. Sometimes the need arises to be able to stop a simulation and resume later between Pathfinder sessions, such as if the computer needs to be restarted after installing a system update.
To stop a simulation, press **Cancel** during a simulation in the simulation dialog. Pathfinder will ask the user if a snapshot should be made. Before selecting **Yes**, make note of the simulation time. After choosing **Yes**, a snapshot file is written into the same directory as the result with a filename similar to the following:

```
untitled_XXXXX.XXX.snapshot
```

where the X's are replaced with the simulation time at which the simulation was stopped. The snapshot file can later be resumed. To resume it, go to the **Simulation** menu, and select **Resume Simulation...** Then select the snapshot file. The simulation will resume from the time it was stopped. Note that the Pathfinder file from which the simulation originated does not have to be open to resume a simulation.

**Stuck Occupants**

Sometimes occupants become "stuck" preventing a proper simulation run. There can be many causes of this problem and we do everything we can to prevent it, but it does happen. If you are having trouble with "stuck" occupants, consider using the SFPE simulation mode with collision handling disabled. This mode uses the simplest set of assumptions and is not very susceptible to the geometric and movement irregularities that can cause occupants to become stuck.
8. Results

Summary Report

The summary report file contains information about the simulation geometry and usage information for each room, stairway, and door. Figure 79 shows an example summary report file.

<table>
<thead>
<tr>
<th>ROOM/DOOR</th>
<th>FIRST IN (s)</th>
<th>LAST OUT (s)</th>
<th>TOTAL USE (pers)</th>
<th>FLOW AVG. (pers/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room01</td>
<td>0.00</td>
<td>25.00</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Room02</td>
<td>0.88</td>
<td>98.10</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>Stair01</td>
<td>2.00</td>
<td>92.02</td>
<td>101</td>
<td></td>
</tr>
<tr>
<td>Room03</td>
<td>2.91</td>
<td>84.28</td>
<td>102</td>
<td></td>
</tr>
<tr>
<td>Room01</td>
<td>0.00</td>
<td>45.00</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Stair02</td>
<td>2.98</td>
<td>90.98</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>Room01</td>
<td>0.00</td>
<td>21.10</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Room02</td>
<td>0.98</td>
<td>71.75</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>Stair03</td>
<td>3.60</td>
<td>66.60</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Room02</td>
<td>2.59</td>
<td>51.25</td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>Room01</td>
<td>0.00</td>
<td>44.75</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Stair04</td>
<td>2.56</td>
<td>40.40</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Room02</td>
<td>0.88</td>
<td>24.53</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Room01</td>
<td>0.00</td>
<td>22.10</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Door00</td>
<td>3.38</td>
<td>95.10</td>
<td>125</td>
<td>1.18</td>
</tr>
<tr>
<td>Door01</td>
<td>0.65</td>
<td>25.00</td>
<td>25</td>
<td>1.00</td>
</tr>
<tr>
<td>Stair01 door 1</td>
<td>11.20</td>
<td>93.03</td>
<td>100</td>
<td>1.27</td>
</tr>
<tr>
<td>Stair01 door 2</td>
<td>3.60</td>
<td>94.20</td>
<td>100</td>
<td>1.24</td>
</tr>
<tr>
<td>Door03</td>
<td>2.93</td>
<td>45.82</td>
<td>25</td>
<td>0.99</td>
</tr>
<tr>
<td>Stair02 door 1</td>
<td>10.38</td>
<td>60.55</td>
<td>75</td>
<td>1.06</td>
</tr>
<tr>
<td>Stair02 door 2</td>
<td>2.95</td>
<td>71.75</td>
<td>75</td>
<td>1.09</td>
</tr>
<tr>
<td>Door04</td>
<td>0.88</td>
<td>21.10</td>
<td>25</td>
<td>1.24</td>
</tr>
<tr>
<td>Stair03 door 1</td>
<td>11.20</td>
<td>66.60</td>
<td>50</td>
<td>0.90</td>
</tr>
<tr>
<td>Stair03 door 2</td>
<td>3.60</td>
<td>51.25</td>
<td>50</td>
<td>1.05</td>
</tr>
<tr>
<td>Stair04 door 1</td>
<td>10.20</td>
<td>40.40</td>
<td>25</td>
<td>0.80</td>
</tr>
<tr>
<td>Stair04 door 2</td>
<td>2.95</td>
<td>24.53</td>
<td>25</td>
<td>1.16</td>
</tr>
<tr>
<td>Door07</td>
<td>2.93</td>
<td>44.75</td>
<td>25</td>
<td>0.80</td>
</tr>
<tr>
<td>Door08</td>
<td>0.88</td>
<td>22.10</td>
<td>25</td>
<td>1.18</td>
</tr>
</tbody>
</table>

SUMMARY: 0.00 98.10 128

Figure 79: Listing for an example summary report file.

This file is shown in the Run Simulation dialog log window and it is also saved in the simulation directory and given the name name_summary.txt (where name is the name of your saved PTH file). The first section shows how many components, mesh triangles, and occupants are in a model. This information can be useful when considering the complexity of a simulation from the standpoint of the simulator.

The table gives a listing of each component (doors, rooms, and stairs) in the simulation. For each component, the FIRST IN column shows the simulation time when the first occupant entered that component. LAST OUT column shows the simulation time when the last occupant exited that component. The TOTAL USE column shows how many times a component was entered by occupants. For doors that served more than 1 occupant, the FLOW AVG. column shows the result of dividing the total use by the amount of time the room was in use (LAST OUT - FIRST IN).
Door Flow Rates
The door history file (*name)_doors.csv, where *name* is the name of your saved PTH file) provides the following information columns in each row:

- **time(s)** - The output time for this data row. The frequency of output is controlled by the CSV Output Freq. box in the Simulation Parameters dialog.
- **exited** - The number of occupants that have successfully passed through an exit door (leaving the simulation).
- **doornname** - The number of occupants who have passed through door *doornname* since the last output.
- **doornname (Q)** - The number of occupants who are waiting in the queue to pass through door *doornname* at the current time. This only includes occupants who have actually reached the door and are waiting to enter. Occupants that are stacked up waiting to reach a door will not be counted. This value is only meaningful in SFPE mode with collisions turned off.

To display this data as a time history plot, click **Door Flow Rates...** on the results menu.

![Flow Rates for Selected Doors](image)

Figure 80: A time history plot for door flow rates

Room History File
The room history file (*name)_rooms.csv, where *name* is the name of your saved PTH file) provides the following information columns in each row:
time(s) - The output time for this data row. The frequency of output is controlled by the CSV Output Freq. box in the Simulation Parameters dialog.

Remaining (Total) - The number of occupants still in the simulation.

Exited (Total) - The number of occupants that have successfully passed through an exit door (leaving the simulation).

roomname - The number of occupants present in room (or stairway) roomname at the current time.

To display this data as a time history plot, click Room Usage... on the results menu.

3D Results
Pathfinder provides a real-time output visualization program for viewing 3D results. It operates much like a video player in that it allows users to play, pause, stop, slide, and speed up and down time. It is completely 3D and allows users to navigate through a model.

Figure 81: 3D Results for the multi-floor-stairwell example problem

Navigating through a model
Once a model is loaded, the navigation tools work similarly to those found in the preprocessor. The user can rotate the model (楸), zoom in and out (楅), and roam (.toInt). Roaming works slightly differently than in the preprocessor in that it works more like a first person video game. Now the keys ‘w’ and ‘s’ move the camera forward and backward, and the keys ‘a’ and ‘d’ move the camera left and right, respectively. In addition, ‘Space’ moves the camera up along the Z-axis, and ‘c’ moves the camera down. Holding ‘Shift’ while pressing any of the movement keys will increase movement speed. Clicking and dragging
the mouse will rotate the camera about its base point. The camera position can be reset by pressing ‘Ctrl-R’.

**Displaying geometry input**
If a DXF, FDS, PyroSim, or background image file has been imported in a Pathfinder simulation, this geometry will be shown by default in the 3D results. If not, the navigation geometry used by the simulator will be displayed, which only contains walking space, doors, stairs, and exits. These two geometry sets can be switched between by selecting Show Navigation Mesh or Show Scene Geometry under the Scene menu. Currently, only one geometry set can be displayed at a time.

**Displaying occupants**
Occupants can be displayed in several ways. They can be shown as simple shapes, as realistic people, or as the artist’s wood mannequin. All display options are found under the Agents menu.

The first way to display occupants is as simple shapes, including disks and cylinders. Because of the simplicity, this is the fastest way to view agents (for both loading and rendering speed), but it is the least realistic and contains little animation.

Another way to display occupants is as realistic people. The avatar selected in the pre-processor determines which avatar is shown in the 3D results. Displayed this way, occupants will render slower and take longer to load, but the scene will appear much more realistic and should still be fast enough to display hundreds to thousands of occupants depending on the processor speed and graphics card.

The last way to display occupants is as the artist’s mannequin. This is the slowest way to display occupants and so it is not as useful for large problems, but it is completely generic, contains animation, and still provides a degree of realism above simple shapes.

**Selecting Occupants**
Occupants can be selected for tracking purposes by clicking on the occupant. When selected, the occupant and their path (if displayed) will turn yellow. Multiple occupants can be selected by holding CTRL when clicking them. They can be de-selected by clicking anywhere else in the model.

**Viewing multi-floor problems**
Some models are composed of several floors, causing each floor to obscure the one below it as shown in Figure 83 (a). Pathfinder provides a variety of options for viewing the model such that the occupants inside can be easily observed. One option is to view the model with the floors stacked vertically but separated by a set amount. Another option is to view the model with the floors laid out in the XY plane so that they can all be viewed from overhead. Both options allow a wall clip-height to be specified.

To use any of the layout options, floors must first be defined. If the floors were defined in the pre-processor, they will carry through to the 3D visualization and no additional input is needed. If they have not been defined or they need to be modified, this can be done by opening the Scene menu and selecting Edit Floors.... A dialog will appear that shows a list of the Z locations of the floors as shown in Figure 82. From this list, floor locations can be added, removed, and modified. Once OK is pressed, the 3D results viewer will partition the geometry among the floors such that the bottom floor contains all
geometry from $-\infty$ to the next floor’s location, the top floor contains all geometry from its location to $+\infty$, and every other floor contains geometry from its location to the next floor’s location.

![Edit Floors dialog](image)

**Figure 82: Floor location dialog for 3D results**

Once the floors are defined, wall clipping can be applied to shorten the walls yet maintain a sense of obstruction placement as shown in Figure 83 (b). As shown in this figure, more of the model can be seen than in Figure 83 (a). The wall height can be set in the toolbar above the 3D view. If this value is set above 0, the geometry on every floor will be clipped above the floor’s Z location plus the wall height. If the value is set to 0, the full wall height is used.

To stack floors vertically along the Z axis, open the **Scene** menu and select **Layout Floors Vertically**. When viewed in this manner, floors will appear naturally such that each floor is stacked on top of the one below it. The floors can then be separated by empty space to more easily view inside the model as shown in Figure 83 (c). This **Floor Separation** can be set in the toolbar above the 3D view.

To layout floors in the XY plane, open the **Scene** menu and select **Layout Floors Horizontally**. The floors will be laid out in a square grid and in one plane. They will appear in order from left to right and top to bottom such that the lowest floor is in the upper left corner and the highest floor is in the lower right corner. When laid out in this manner, the **Floor Separation** will affect the gap between floors in both the X and Y directions. An example of this type of layout is shown in Figure 83 (d). By default, labels appear above each floor so the floors can be easily identified, but these labels can be hidden by opening the **View** menu and deselecting **Show Labels**.
Figure 83: Multi-floor layout options in 3D results (FDS model courtesy of Andreas Niggemeyer)

**Animation playback**

To play back animation, press the play button (▶). As the animation is playing, the time slider will move, and the animation can be paused (||) or stopped (■). The buttons (◀) and (▶) will move the time slider to the beginning and end, respectively. The buttons (◀) and (▶) will slow down and speed up the animation by factors of two.

The status bar at the bottom of the screen shows information about playback. The first section from left to right shows the current playback status. This will display “Playing,” “Paused,” or “Stopped.” The following section shows the current playback time in minutes. The next section shows the current playback speed. The last section shows the current rendering speed in frames per second—a common speed measurement in computer graphics. This can help determine how well a user’s computer handles 3D playback. Some ways to increase this are discussed in the section, Controlling drawing detail/speed.

**Refreshing Results**

Results can be viewed as a simulation is running, but they will only be current to the last load or refresh. To refresh the results at any time, press F5 on the keyboard or select Refresh Results in the File menu.
The current playback time will be restored after refreshing the results, making the refresh as seamless as possible. If the results are viewed before the simulation is finished, upon completion the results will automatically be refreshed and brought to the front of the screen.

**Viewing occupant paths**

One option that can help visualize flow in an evacuation is to turn on occupant paths. This can be enabled by checking **Show Occupant Paths** in the **View** menu. When turned on, each occupant’s path will be drawn from t=0 to the current playing time.

**Controlling drawing detail/speed**

There are several options controlling the drawing detail and ultimately speed in the 3D results, including level-of-detail rendering, hardware skinning, and vertex buffers.

One way to vastly increase speed while only somewhat sacrificing quality is to enable view-dependent level-of-detail rendering. This can be enabled by checking **Enable Level of Detail** under the **View** menu. The idea behind this option is that objects far from the camera require less detail to portray the object realistically than for those close to the camera. Pathfinder supports level-of-detail rendering by using progressive meshes, which is a technology that enables the use of one model that represents thousands of detail levels with very little memory overhead.

Another improvement for most video cards is to use hardware skinning. To enable it, check **Enable Hardware Skinning** under the **View** menu. In some cases, hardware skinning can provide as much as a 2X speed improvement. Some older graphics cards, however, will support it but will actually render slower when using it. It is recommended that the user play with this option and observe the difference in frame rate (shown at the bottom right in the status bar).

The last speed option available is using vertex buffers, which is enabled by checking **Enable Vertex Buffers** under the **View** menu. Hardware vertex buffers allow geometric data to be stored in video memory to reduce data that must be sent over the graphics bus from main memory, which can increase rendering speed. We have found, however, that integrated Intel video cards often have trouble with this option, so it may need to be disabled for these cards.

The two options, **Enable Hardware Skinning** and **Enable Vertex Buffers**, when combined tend to provide the most benefit on newer video hardware.

**Creating Movies**

Movies can be created from the 3D results for playback on a PC using a video player such as Windows Media Player. Creating a movie file allows the results to be distributed to others who do not have the 3D results software that is bundled with Pathfinder. Movies can be created in two different ways. One way is to create a high-quality movie that is rendered offline from a fixed camera angle. The other is to create a lower-quality movie in real-time that allows the camera angle and scene to change dynamically.

**High Quality Movies**

High quality movies are useful if a user wants a movie that is unrestricted by size and frame rate. This means that it will play back smoothly at any resolution and with any high-quality settings turned on,
regardless of the complexity of the scene. The major disadvantage to this type of movie is that the camera angle remains fixed throughout the length of the movie, and the user cannot interact with the scene (such as changing the selected occupant, turning on and off paths, etc.) while the movie is being created.

To create a high-quality movie, open the File menu and select Create Movie…. A file chooser will ask for the file name of the resulting movie. From this file chooser, the type of movie can be specified as an Audio-Video Interlaced (AVI) file or a Windows Media Format (WMV) file. AVI files can be rendered as uncompressed or compressed. WMV files can only be compressed. Uncompressed files will be very large but will be of the highest-quality. Compressed files are much smaller in size but with some reduced quality. To create compressed AVI files, video codecs must be installed on both the computer that will create the file and the computer that will play back the file. Some popular AVI codecs include Xvid, Divx, and ffdshow. WMV files, however, do not require special codecs to be installed on either the source or destination computers, but they will only work on Windows machines unless special software is installed on another platform.

Once the filename and type of video has been chosen, a dialog will show some movie making options as in Figure 84 (a). The options are as follows:

- **Video Size** specifies the resulting video’s dimensions. This is only limited by the maximum size of a viewport on the computer’s video hardware; with some codecs, however, each dimension must be a multiple of 2 or 4. If you have trouble creating a movie, try making the size a multiple of 4. The Use window size button will set the size to the 3D window’s current size.

- **Framerate** determines how smoothly the video will play back. The higher this number is, the smoother the playback at the expense of longer rendering time to create the movie and larger file size. 30 frames/second provides reasonably smooth video playback.

- **Speed** specifies the speed at which the results will play. 1 X will play the movie at real-time speed, 2 X will play the movie twice real-time, etc.

- **Enable Level of Detail** specifies that level of detail rendering should be turned on while creating the movie. This will lower the resulting quality, but it will decrease the time to make the movie on scenes with many occupants.

- **Watch Movie when Finished** specifies that the resulting movie should open in the default video player for the chosen video type when the movie is completed.

- **Compressor** shows which video codec is currently selected and allows the codec to be chosen and configured. If Configure… is pressed, another dialog will show as in Figure 84 (b). This dialog will show a list of the codecs currently installed on the computer. Some codecs allow certain properties, such as the Quality, Data Rate, and Keyframe interval to be specified. These properties control the resulting movie’s quality, file size, and seeking performance (how well a movie can be skipped around in the video player), respectively. Some codecs do not expose these properties through this dialog, however. To configure these codecs, you must press the additional Configure… button if it is enabled.
Once the properties have been specified, press **OK** to start making the movie. While the movie is being created, a progress dialog will show how close the movie is to being finished. If the movie is cancelled before it is completed, there will still be a valid video; it just will not play the entire results.

**Real-time Movies**

Movies can also be created in real-time. This means that it will record while the user is interacting with the results and it will record everything the user sees except for the cursor. The disadvantage of this type of movie is that it will play back only as smooth and of the same quality as that which the user who created the movie saw. So if the scene is very complex and the movie creator’s computer cannot view the results smoothly, the resulting movie’s play back will suffer as well.

To create a movie of this type, press the record button (/button). A file chooser dialog will prompt for the file name of the movie. For real-time movies the only allowable type is WMV. Once the file name is chosen, the codec configuration dialog will be shown as in Figure 84 (b). When **OK** is pressed on this dialog, the movie will begin recording. At this point, anything the user sees will be recorded in the movie. Now the user can change the camera angle, start and stop playback, select occupants, change view settings, etc. and the movie will capture everything. At any time, the movie can be paused or stopped. Pausing the movie will stop the recording but leave the movie file open so that recording can be resumed to the same file. This allows the user to perform some action that they do not want to be recorded. To pause movie recording, press the pause movie button (/button). To resume recording, press the resume movie button (/button). Stopping the movie will end recording and disallow any further recording to the file. To stop recording, press the stop movie button (/button).
9. Index

2D View, 5, 6
   Navigating, 7
3D Results, 68
   Casual Dress, 69
   Mannequin, 69
   Navigating, 68
   Simple Shapes, 69
3D View, 5, 6
   Navigating, 6
Add Occupants, 47
Add Occupants Dialog, 47
Animation Playback, 71
Background Images, 31
Collision Handling, 62, 63
Door History File, 67
Door Tool, 20, 21
Doors, 11, 20
   Exit, 30
   Thick, 21
   Thin, 20
DXF Files, 32
Edit Profiles Dialog, 38
FDS Files, 34
Floors, 5, 6, 11
   Changing Active Floor, 13
   Creating, 13
   Editing, 14
Imported Geometry, 5
Importing Files, 31
Inertia, 63
Merge, 17
Navigation View, 5
Normal Tools, 8
Obstructions, 15, 18, 19
Occupant Group Tool, 46
Occupant Tool, 45
Occupants, 5
   Adding, 45
   Creating, 38
   Stuck, 65
One Point Stair Tool, 24
Orbit Tool, 7
Orthographic Camera, 6
Pan Tool, 7
Perspective Camera, 6
Polygonal Room Tool, 15, 18
Profiles, 5, 38
Property Panel, 6
Reactive Steering Mode, 62, 63
Rectangular Room Tool, 15, 18
Refresh Results, 71
Roam Tool, 7
Room History File, 67
Rooms, 11, 14
   Adding New Rooms, 14
   Dividing, 16
   Merging Rooms, 17
   Separating Rooms, 17
Run Simulation, 63
Run Simulation Dialog, 63
Separate, 17
SFPE Mode, 62
Show Occupant Paths, 72
Simulation Parameters Dialog, 61
Snap Grid, 8
Snapshot, 65
Stairs, 11, 22
   Between Edges, 23
   Extending from one Edge, 24
Sticky Tools, 8
Summary Report, 66
Two Point Stair Tool, 23
Views, 5
   Drawing in, 8
   Navigation View, 5
   Resetting, 7
Visibility, 6
Wall Tool, 19
Walls, 19
Zoom Tool, 7